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Connecting to a TV
 Except for H8509S, H8909S model 

 For H8509S, H8909S model 

"" Depending on your model, rear panel may be different. For more details, please refer to 

the user manual of product.

"" The RF cable connection of this product sends only signals of TV. You must connect 

the HDMI cable to watch output from your product.

"" If you use an HDMI-to-DVI cable to connect to your display device, you must also 

connect the Digital Audio Out on the product to audio system to hear audio.

"" Depending on your TV, certain HDMI output resolutions may not work. Please refer to 

the user manual of your TV.

"" When you connect the product to the TV using the HDMI cable for the first time or to a 

new TV, the HDMI output resolution will be automatically set to the highest supported 

by the TV.

"" A long HDMI cable may cause a screen noise. If this occurs, set HDMI Deep Colour to 

Off in the menu.

"" If the product is connected to your TV in the HDMI 720p, 1080i, or 1080p output mode, 

you must use a High speed (category 2) HDMI cable.

Connections
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"" HDMI outputs only a pure digital signal to the TV. If your TV does not support HDCP 

(High-bandwidth Digital Content Protection), random noise appears on the screen.

"" Do not connect the power cord until you have made all the other connections. When 

you change the connections, turn off all devices before you start.

"" If connecting with 2 RF cables from the same satellite dish, you can watch and record 

different channels. Twin LNB is recommended. Set "Aerial Connection Type" to "Dual" 

in the Broadcasting option.  For H8509S,H8909S model 

"" If connecting with one RF cable, you cannot view second channel while 

recording a channel. Set "Aerial Connection Type" to "Single" in the Broadcasting 

option.  For H8509S,H8909S model 
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Connecting to an Audio Sys-
tem

Method 1: Connecting to an HDMI 
supported AV receiver

Method 2: Connecting to an AV 
receiver with Optical input

"" After finishing the connections, press the input selector of the connected audio system 

and TV until the video signal from the product appears on your TV and you hear the 

audio signal through your audio system.

"" Do not connect the power cord until you have made all the other connections. When 

you change the connections, turn off all devices before you start.
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Connecting to a Network 
Router
You can connect your product to your network router using one of the methods 

illustrated below.

Wired Network

"" Internet access to Samsung’s software update server may not be allowed, depending 

on the router you use or your ISP’s policy. For more information, contact your ISP 

(Internet Service Provider).

"" For DSL users, please use a router to make a network connection.

https://manualsfile.com


10

Wireless Network

"" If the wireless router supports DHCP, your product can use a DHCP or static IP address 

to connect to the wireless network.

"" Set your wireless router to Infrastructure mode. Ad-hoc mode is not supported.

"" The product supports only the following wireless security key protocols: WEP (OPEN/

SHARED), WPA-PSK (TKIP/AES), WPA2-PSK (TKIP/AES)

"" Select a channel on the wireless router that is not currently being used. If the channel 

set for the wireless router is currently being used by another device nearby, it will result 

in interference and communication failure.

"" If you select the Pure High-throughput (Greenfield) 802.11n mode and set the 

Encryption type on your router or router to WEP, TKIP or TKIP-AES (WPS2Mixed), 

the product will not support a connection in compliance with new Wi-Fi certification 

specifications.

"" If your router supports WPS (Wi-Fi Protected Setup), you can connect to the network 

via PBC (Push Button Configuration) or PIN (Personal Identification Number). WPS will 

automatically configure the SSID and WPA key in either mode.

"" Wireless LAN, by its nature, may cause interference, depending on the operating 

conditions (router performance, distance, obstacles, interference by other radio 

devices, etc).
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The Home Screen

PLAY DISC FILMS AND TV SHOWS MULTIMEDIA SAMSUNG APPS

Audio CD

WebBrowser e-Manual 3 4 5 6 Recorded 
TV

Schedule 
Manager

Screen 
Mirroring

Settings

PLAY DISC : Lets you play photos, videos, or music content from Disc.

FILMS AND TV SHOWS : Lets you view Films and TV Shows from the Internet.

"" Depending on your country, this menu function may not be supported.

MULTIMEDIA : Lets you play photos, videos, or music content from USB or mobile 
devices, or PCs.

Sign In : Lets you log in with your Samsung account.

Search : Lets you search for contents in Films and TV Shows, Apps and YouTube by 
entering corresponding search words

SAMSUNG APPS : Gives you access to various for applications you can download.

My Apps : Apps downloaded from My Apps are displayed.

Recorded TV : Access Recorded TV directly.

Schedule Manager : Reserve the desired TV programmes.

Screen Mirroring : Lets you view the screen of your smart phone or android tablet 
on a TV you have connected to the product.

Settings : Opens the product's menu. In the menu can set various functions to suit 
your personal preferences.

"" In the Home menu screen, it will switch to DTV Channel mode after 3 minutes. When 

accessing the Settings menu, the screen saver will be activated after 5 minutes. Saves 

power by turning off product automatically when no user operation is received for 4 

hours. If Auto Power Off menu is set to Off, the power will not turn off automatically.

Settings
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Picture

Picture

UHD Output	 Auto

3D Settings

TV Aspect Ratio	 16:9 Original

BD Wise	 Off

Resolution	 Auto

DTV Smart Resolution	 Off

Movie Frame (24fps)	 Auto

UHD Output  For BD-H89 series 

This option outputs HDMI video at UHD (Ultra High definition) resolution. This is 

only available when Movie Frame is set to Auto.

"" To use this feature, you must connect the product to a device that supports UHD 

resolution and you must have content that plays at 24fs (film speed).

"" This device cannot play UHD contents However contents with resolution lower than Full 

HD can be up-scaled to UHD.

"" For UHD resolution output, only 2160*3840 24 frame rate output is available.

3D Settings
Select whether to play a Blu-ray Disc with 3D contents in 3D Mode.

"" If you move to the Home or Samsung Apps screen while in 3D mode, the product will 

switch to 2D mode automatically.
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3D Blu-ray Playback Mode  Try Now 

Set whether to play 3D Blu-ray disc in 3D or 2D image.

●● Auto : Automatically detect if a connected TV has 3D capability and play a Blu-

ray 3D disc in 3D or 2D accordingly or a 3D only disc in 3D if the TV supports 

3D. 3D only discs will not be played if your TV does not support 3D.

●● 3D → 3D : Play 3D only and Blu-ray 3D discs in 3D mode at all times.

●● 3D → 2D : Play Blu-ray 3D discs in 2D mode at all times. 3D only discs will not 

be played.

"" For some 3D discs, to stop a movie during 3D playback, press the ' button once. The 

movie stops and the 3D mode option is de-activated. To change a 3D option selection 

when you are playing a 3D movie, press the ' button once. The Home Screen menu 

appears. Press the ' button again, then select 3D Settings in the Blu-ray menu.

"" Depending on the content and the position of the picture on your TV screen, you may 

see vertical black bars on the left side, right side, or both sides.

Screen Size  Try Now 

Lets you enter the actual screen size of your TV so that the product can adjust 

the image according to the screen size and display an optimal 3D image. (For 3D 

displays bigger than 116 inches, simply setting it as 116 is a safe choice.)

"" As the video resolution in 3D play mode is fixed according to the resolution of the 

original 3D video, you can not change the resolution to your preference.

"" Some functions such as BD Wise, screen size adjustment, and resolution adjustment 

may not operate properly in 3D play mode.

"" You must use a high-speed HDMI cable for proper output of the 3D signal.

"" Stay at least three times the width of the screen from the TV when watching 3D 

images. For example, if you have a 46 inch screen, stay 138 inches (11.5 feet) from the 

screen. Place the 3D video screen at eye level for the best 3D picture.

"" When the product is connected to some 3D devices, the 3D effect may not function 

properly.

"" “Blu-ray 3D” and “Blu-ray 3D” logo are trademarks of the Blu-ray Disc Association.
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TV Aspect Ratio  Try Now 

Lets you adjust the output of the product to the screen size of your TV.

●● 16:9 Original : Select when you connect the product to a 16:9 TV screen. The 

product will display all content in its original aspect ratio. Content formatted 

in 4:3 will be displayed with black bars on the left and right.

●● 16:9 Full : Select when you connect the product to a 16:9 TV screen. All content 

will fill the full screen. Content formatted in 4:3 will be stretched.

●● 4:3 Letter Box : Select when you connect the product to a 4:3 TV screen. The 

product will display all content in its original aspect ratio. Content formatted 

in 16:9 will be displayed with black bars on the top and bottom.

●● 4:3 Pan-Scan : Select when you connect the product to a 4:3 TV screen. 16:9 

content will have the extreme left and right portions cut off.

"" Depending on the disc type, some aspect ratios may not be available.

"" If you select an aspect ratio and option which is different than the aspect ratio of your 

TV screen, then the picture might appear to be distorted.

"" If you select the 16:9 Original, your TV may display 4:3 Pillarbox (black bars on sides 

of picture).

BD Wise (Samsung Products 
only)  Try Now 

When you connect a Samsung product and a Samsung TV with BD Wise to each 

other via HDMI, and BD Wise is on in both the product and TV, the product outputs 

video at the video resolution and frame rate of the play contents.

●● Off : The output resolution stays fixed at the resolution you set previously in 

the Resolution menu, regardless of the resolution of the disc. See Resolution 

below.

●● On : The product outputs video at the original resolution and frame rate of the 

play contents.
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"" When BD Wise is on, the Resolution setting automatically defaults to BD Wise and BD 

Wise appears in the Resolution menu. 

"" If the product is connected to a device that does not support BD Wise, you can not use 

the BD Wise function.

"" For proper operation of BD Wise, set the BD Wise menu of both the product and the TV 

to On.

Resolution  Try Now 

Set the output resolution of the HDMI video signal.

The number indicates the number of lines of video per frame. The i and p indicate 

interlaced and progressive scan, respectively. The more lines, the higher quality.

●● BD Wise : Automatically sets the resolution to the resolution of the play 

contents. if you have connected the product via HDMI to a TV with the BD 

Wise feature. (The BD Wise menu item appears only if BD Wise is set to On. 

See BD Wise above.)

●● Auto : Automatically sets the output resolution to the connected TV’s maximum 

resolution.

●● 1080p : Outputs 1080 lines of progressive video.

●● 1080i : Outputs 1080 lines of interlaced video.

●● 720p : Outputs 720 lines of progressive video.

●● 576p/480p : Outputs 576/480 lines of progressive video.
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Resolution according to the output mode

●● Blu-ray Disc/E-contents/Digital Contents/DTV/DVD playback

 For BD-H85 series 

Resolution Blu-ray Disc
E-contents/Digital 

contents/DTV 
DVD

BD Wise
Resolution of Blu-ray 

Disc
1080p 576i/480i

Auto
Max. Resolution of TV 

input
Max. Resolution of TV 

input
Max. Resolution of TV 

input

1080p 1080p 1080p 1080p

1080i 1080i 1080i 1080i

720p 720p 720p 720p

576p/480p 576p/480p 576p/480p 576p/480p

 For BD-H89 series 

Resolution Blu-ray Disc
E-contents/

Digital 
contents

DTV DVD

BD Wise
Resolution of 
Blu-ray Disc

1080p 1080p 576i/480i

Auto

Movie Frame : 
Auto

(UHD Output : Auto)

2160p@24F 2160p@24F
Max. 

Resolution of 
TV input

Max. 
Resolution of 

TV input

Movie Frame : Off
Max. 

Resolution of 
TV input

Max. 
Resolution of 

TV input

1080p 1080p 1080p 1080p 1080p

1080i 1080i 1080i 1080i 1080i

720p 720p 720p 720p 720p

576p/480p 576p/480p 576p/480p 576p/480p 576p/480p

"" If the screen stays blank after you have changed the resolution, remove all discs, and 

then press the HOME button on the remote control. Press and hold the ' button on 

the top of the product for more than 5 seconds. All settings are restored to the factory 

default.

"" When the factory default settings are restored, all stored user BD data is deleted.

"" The Blu-ray Disc must have the 24 frame feature for the product to use the Movie 

Frame (24fps) mode.
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DTV Smart Resolution  Try Now 

Use this function to automatically optimise screen resolution for digital broadcasts.

●● Auto : Screen resolution is automatically optimised for digital broadcast.

●● Off : Turn off DTV Smart Resolution.

"" When you change your TV channel with this function set to Auto, according your TV, 

the display time of next channels may take longer than the function set to Off.

"" DTV smart resolution is activated only when resolution option is set to Auto.

Movie Frame (24fps)  Try Now 

Setting the Movie Frame (24fps) feature to Auto lets the play adjust its HDMI 

output to 24 frames per second for improved picture quality. You can enjoy the 

Movie Frame (24fps) feature only on a TV supporting this frame rate. Movie Frame 

is only available when the product is in the 1080p output resolution modes.

●● Auto : Movie Frame (24fps) functions work.

●● Off : Movie Frame (24fps) functions are off.

Fit Screen Size  Try Now 

Set the screen to the optimal size. (Apply Smart Hub, Screen Mirroring only)

"" If displayed e-Manual page on your TV screen is incomplete and partially hidden, set 

he Fit Screen Size to Size 1.
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HDMI Colour Format  Try Now 

Set the colour space format for HDMI output, depending on the connected device.

●● Auto : Automatically set the optimum format supported by the connected 

display device.

●● YCbCr (4:4:4) : Recommended when connected to a display that supported 

YCbCr (4:4:4) because most films are in this format.

●● RGB (Standard) : Recommended when connected to a display that does not 

support the YCbCr format. Select this for output of the normal range of RGB 

colours.

●● RGB (Enhanced) : Select this for output of an enhanced range of RGB colours. 

Not recommended for general use because it will increase the contrast 

between black and white.

HDMI Deep Colour  Try Now 

Lets you output video from the HDMI OUT jack with Deep colour. Deep colour 

provides more accurate colour reproduction with greater colour depth.

●● Auto : The product outputs video with Deep Colour to a connected TV which 

supports HDMI Deep Colour.

●● Off : The picture is output without Deep Colour.

Progressive Mode  Try Now 

Lets you improve picture quality when viewing DVDs.

●● Auto : Select to have the product automatically select the best picture quality 

for the DVD you’re watching.

●● Video : Select for the best picture quality from concert or TV show DVDs.
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Sound

Sound

Digital Output	 PCM

PCM Downsampling	 On

Dynamic Range Control	 Auto

Downmixing Mode	 Normal Stereo

DTS Neo:6 Mode	 Off

Audio Sync	 0 ms

Connected Device	 AV Receiver

Digital Output  Try Now 

You set the Digital Output to match the capabilities of the AV receiver you’ve 

connected to the product : 

●● PCM : Choose if you have connected an HDMI supported AV receiver.

●● Bitstream (Unprocessed) : Select if you have connected an HDMI supported AV 

receiver with Dolby TrueHD and DTS-HD Master Audio decoding capabilities.

●● Bitstream (Re-encoded DTS) : Choose if you have connected an AV receiver 

using a Digital Optical input that can decode DTS.

●● Bitstream (Re-encoded Dolby D) : Select if you don’t have an HDMI supported 

AV receiver, but have an AV receiver with Dolby Digital decoding capabilities.

"" Be sure to select the correct Digital Output or you will hear no sound or a loud noise.

"" If the HDMI device (AV receiver, TV) is not compatible with compressed formats (Dolby 

digital, DTS), the audio signal outputs as PCM.

"" Regular DVDs do not have BONUSVIEW audio and Navigation Sound Effects.
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Digital Output Selection

Audio Stream on Blu-ray Disc

Setup Connection Audio source stream Outputs

PCM Up to PCM 7.1ch

Dolby Digital Up to PCM 7.1ch

Dolby Digital Plus Up to PCM 7.1ch

HDMI supported 
Avreceiver

Dolby TrueHD Up to PCM 7.1ch

DTS Up to PCM 6.1ch

DTSHD High Resolution 
Audio

Up to PCM 7.1ch

DTS-HD Master Audio Up to PCM 7.1ch

PCM PCM PCM 2ch

Dolby Digital PCM 2ch

Dolby Digital Plus PCM 2ch

Optical Dolby TrueHD PCM 2ch

DTS PCM 2ch

DTSHD High Resolution 
Audio

PCM 2ch

DTS-HD Master Audio PCM 2ch

PCM PCM

Dolby Digital Dolby Digital

Dolby Digital Plus Dolby Digital Plus

HDMI supported 
AV receiver

Dolby TrueHD Dolby TrueHD

DTS DTS

DTSHD High Resolution 
Audio

DTSHD High Resolution 
Audio

DTS-HD Master Audio DTS-HD Master Audio

Bitstream 
(Unprocessed)

PCM PCM 2ch

Dolby Digital Dolby Digital

Dolby Digital Plus Dolby Digital

Optical Dolby TrueHD Dolby Digital

DTS DTS

DTSHD High Resolution 
Audio

DTS

DTS-HD Master Audio DTS
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Setup Connection Audio source stream Outputs

PCM Re-encoded DTS

Dolby Digital Re-encoded DTS

Dolby Digital Plus Re-encoded DTS

Bitstream (Re-
encoded DTS)

HDMI supported 
AV receiver or 

Optical
Dolby TrueHD Re-encoded DTS

DTS Re-encoded DTS

DTSHD High Resolution 
Audio

Re-encoded DTS

DTS-HD Master Audio Re-encoded DTS

PCM Re-encoded Dolby Digital *

Dolby Digital Re-encoded Dolby Digital *

Dolby Digital Plus Re-encoded Dolby Digital *

Bitstream (Re-
encoded Dolby 

D)

HDMI supported 
AV receiver or 

Optical
Dolby TrueHD Re-encoded Dolby Digital *

DTS Re-encoded Dolby Digital *

DTSHD High Resolution 
Audio

Re-encoded Dolby Digital *

DTS-HD Master Audio Re-encoded Dolby Digital *

Audio Stream on DVD

Setup Connection Audio source stream Outputs

PCM PCM 2ch

HDMI supported 
AVreceiver

Dolby Digital Up to PCM 5.1ch

PCM DTS Up to PCM 6.1ch

PCM PCM 2ch

Optical Dolby Digital PCM 2ch

DTS PCM 2ch

PCM PCM 2ch

HDMI 
supportedAV 

receiver
Dolby Digital Dolby Digital

Bitstream 
(Unprocessed)

DTS DTS

PCM PCM 2ch

Optical Dolby Digital Dolby Digital

DTS DTS

PCM PCM 2ch

Bitstream (Re-
encoded DTS)

HDMI supported 
AV receiver or 

Optical
Dolby Digital Dolby Digital

DTS DTS
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Setup Connection Audio source stream Outputs

PCM PCM 2ch

Bitstream (Re-
encoded Dolby 

D)

HDMI supported 
AV receiver or 

Optical
Dolby Digital Dolby Digital

DTS DTS

Audio Stream of Broadcast

Setup Connection Audio source stream Outputs

Dolby Digital Up to PCM 5.1ch

Dolby Digital Plus Up to PCM 5.1ch

HDMI supported 

AVreceiver

MPEG1
Layer 2

Up to PCM 5.1ch

PCM HE-AAC Up to PCM 5.1ch

Dolby Digital PCM 2ch

Dolby Digital Plus PCM 2ch

Optical
MPEG1
Layer 2

PCM 2ch

HE-AAC PCM 2ch

Dolby Digital Dolby Digital

Dolby Digital Plus Dolby Digital Plus**

HDMI supported 
AV receiver

MPEG1
Layer 2

PCM 2ch

Bitstream 
(Unprocessed)

HE-AAC
Re-encoded Dolby Digital 

***

Dolby Digital Dolby Digital

Dolby Digital Plus Dolby Digital

Optical
MPEG1
Layer 2

PCM 2ch

HE-AAC
Re-encoded Dolby Digital 

***

Dolby Digital Re-encoded DTS

Dolby Digital Plus Re-encoded DTS

Bitstream (Re-
encoded DTS)

HDMI supported 
AV receiver or 

Optical

MPEG1
Layer 2

PCM 2ch

HE-AAC Re-encoded DTS ***

Dolby Digital Re-encoded Dolby Digital 

Dolby Digital Plus Re-encoded Dolby Digital 

Bitstream (Re-
encoded Dolby 

D)

HDMI supported 
AV receiver or 

Optical

MPEG1
Layer 2

PCM 2ch

HE-AAC
Re-encoded Dolby Digital 

***
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Definition for Blu-ray Disc

Setup Connection
Audio source 

stream
Outputs

PCM
HDMI supported 

AVreceiver
Any

Decodes the main feature audio and 
BONUSVIEW audio stream together 
into PCM audio and adds Navigation 

Sound Effects.

Optical

Bitstream 
(Unprocessed)

HDMI supported 
AV receiver

Any

Outputs only the main feature audio 
stream so that your AV receiver can 

decode the audio bitstream. You 
will not hear BONUSVIEW audio or 

Navigation Sound Effects.

Optical

Bitstream (Re-
encoded DTS)

HDMI supported 
AV receiver or 

Optical
Any

Decodes the main feature audio and 
BONUSVIEW audio stream together 
into PCM audio and adds Navigation 
Sound Effects, then reencodes the 

PCM audio into DTS bitstream.

Bitstream (Re-
encoded Dolby 

D)

HDMI supported 
AV receiver or 

Optical
Any

Decodes the main feature audio and 
BONUSVIEW audio stream together 
into PCM audio and adds Navigation 

Sound Effects, then reencodes 
the PCM audio into Dolby Digital 

bitstream.

* If the Source Stream is 2ch or mono, "Re-encoded Dolby D" setting is not 

applied. Output will be PCM 2ch. 

** If the Audio Description is set to On, audio output will be changed Dolby 

Digital even if the original broadcast stream is Dolby Digital Plus.

*** If the Audio Description is set to On and sampling rate of less 48kHz, audio 

output will be changed PCM even if the Bitstream is selected.
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PCM Downsampling  Try Now 

Set whether to use downsampling processing or not.

●● Off : Select when the AV receiver connected to the product is 96kHz compatible.

●● On : Select when the AV receiver connected to the product is not 96kHz 

compatible. 96kHz signals will be down converted to 48kHz.

"" Even when PCM Downsampling is set to Off, some discs will only output 

downsampled audio through the optical digital outputs.

"" If your TV is not compatible with compressed multi-channel formats (Dolby Digital, 

DTS), the product may output PCM 2ch downmixed audio even though you set the 

digital output as Bitstream (unprocessed/Re-encoded DTS/Re-encoded Dolby D) on 

your setup menu.

"" If your TV is not compatible with PCM sampling rates over 48kHz, the product may 

output 48kHz downsampled PCM audio even though you set PCM Downsampling to 

Off.

Dynamic Range Control  Try Now 

Set Dynamic Range control option for Dolby Digital, Dolby Digital Plus and Dolby 

TrueHD.

●● Auto : The Dynamic Range will be controlled automatically based on the 

information provided by the Dolby TrueHD Soundtrack. This setting is same 

with "On" for Dolby Digital and Dolby Digital Plus.

●● Off : You can enjoy original sound without compressing Dynamic Range of the 

sound.

●● On : The Dynamic Range is compressed appropriately by boosting low level 

sound and reducing extremely loud sound.
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Downmixing Mode  Try Now 

Select Downmix method for stereo output.

●● Normal Stereo : Downmixes the multi-channel audio into two channel stereo. 

Choose when connected to equipment that does not support virtual surround 

functions such as Dolby Pro Logic.

●● Surround Compatible : Downmixes multi-channel audio into surround 

compatible stereo. Choose when connected to equipment that supports virtual 

surround functions such as Dolby Pro Logic.

DTS Neo:6 Mode  Try Now 

You can enjoy multichannel sound via HDMI output even for 2 channels audio 

source.

●● Off : Outputs a 2-channel audio signal through the front speakers only.

●● Cinema : Select to play 2-channel movie sound over multi-channels.

●● Music : Select to play 2-channel music over multi-channels.

"" If you are using an HDMI supported AV receiver, this option is available when you set 

Digital Output setup as PCM.

Audio Sync  Try Now 

In some cases when the product is connected to a digital TV, the audio signal may 

not synchronize with the video signal. If this occurs, adjust the audio delay time to 

match the video signal.

●● You can set the audio delay time between 0 msec and 250 msec. Adjust it to 

the optimal setting.

"" The audio delay time you specify may not be exact depending on the played content.
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Connected Device  Try Now 

Choose an equipment that you have connected to this product to hear the sound 

in addition to your TV. Loudness of DTV Programme will be adjusted according to 

your equipment.

●● AV Receiver : Select this If you use a general AV Receiver / Home Theatre 

Equipment or a Television to hear sound. 

●● AV Receiver (Offset Mode) : Select this if your case is one of two shown below. 

–– If you use THX Certified AV Receiver / Home Theatre Equipment. 

–– In case Digital Output is set to Bitstream, and If you feel the Dolby Audio 

much louder than MPEG1 Layer2 Audio while watching DTV Programme, 

select this even if your AV Receiver is not THX Certified one.

●● Stereo Device : Select this if you use a Stereo Amplifier or Recording Device 

that support Optical Digital Audio Input as PCM format.

"" For users whose TV is the only sound-producing device: 1) If the TV does not support 

Dolby Digital bitstream input via HDMI, no specific setting is required. 2) If the TV 

supports Dolby Digital bitstream input via HDMI, set Connected Device to Stereo.

"" If the DTV Programme you are watching is produced according to EBU R128, The 

Average Loudness between MPEG1 Layer2 Audio, Dolby Digital Audio, Dolby Digital 

Plus Audio, HE-AAC Audio can be reduced. If the DTV Programme do not meet the 

EBU R128, there may be still some amount of difference of average Loudness between 

a TV Programmes.

"" Substantial number of AV Receiver / Home Theatre Device decode Dolby Digital / 

Dolby Digital Plus with +4dB OFFSET when compared to same encoding level of PCM 

input. This kind of product include both THX Certified one and also none THX Certified 

one. If user select "AV Receiver (Offset Mode)", the average loudness between Dolby 

Digtial / Dolby Digital Plus audio decoded by such a product and MPEG1 Layer2 Audio 

decoded by this product will be similar.
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Broadcasting
You can configure your TV channels with features such as country and auto tune.

Broadcasting

Auto Tuning	

Aerial	 Terrestrial

Channel List	

Guide	

Schedule Manager	

Edit Channel	

Edit Favourites	

Auto Tuning  Try Now 

Scans all channels and stores them in the product’s memory.

Auto Tuning
Configure auto-tuning settings to scan and store channels.

Standby Auto Tuning
Auto-tune channels while your device is in standby mode.

"" This menu can be available when country set to Hungary, Finland and Italy and TV 

mode is Astra HD + or Sky.
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Cable Search Option  Except for H8509S, H8909S, H8500A, H8900A model 

Configure search settings, such as frequency and symbol rate, for cable network.

Wake-up Timer
Schedule timer to turn the TV on and scan channels automatically.

"" This menu can be available when country set to Hungary, Finland and Italy and TV 

mode is Astra HD + or Sky.

Aerial  Except for H8500A, H8900A, H8509S, H8909S model 

Selects an appropriate type of aerial for digital broadcasts.

Before your product can begin memorizing the available channels, you must specify 

the type of signal source that is connected to the this product.

Channel List  Try Now 

Select this to check the stored channels.

You can see TV channels in several ways.

Guide  Try Now 

Provide programme information for each channels.

"" Depending on your country, this menu function may not be supported.
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Schedule Manager  Try Now 

It can manager lists for schedule viewing or recording.

"" Depending on your country, this menu function may not be supported.

Edit Channel  Try Now 

It is provided to edit functions for channel.

Edit Favourites  Try Now 

It is provided to make and edit favourite lists for channel.

Channel Settings

Country (Area)  Try Now 

Select your country so that the TV can correctly auto-tune the broadcasting 

channels.

"" Password : Enter the desired 4-digit password using the number buttons. 1) Belgium, 

France, Italy, Norway : You can not set the password to "0000". Please choose other 

numbers. 2) Others : Default password is set to 0000.

"" Channel Ordering menu can be displayed when the country set to Italy.
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Manual Tuning  Try Now 

Scans for a channel manually and stores in the product.

When scanning has finished, channels are updated in the channel list.

Transfer Channel list  Try Now 

This function can import or export the channel map.

You should connect a USB storage to use this function.

●● Import from USB : Import channel list from USB.

●● Export to USB : Export channel list to USB.

"" If you set the country to Netherlands and Antenna source set to cable, this menu will 

not appear.

Delete CAM operator profile  Except for H8500A, H8900A model 

Select this menu to delete the CAM operator profile.

Satellite System  For H8509S, H8909S model 

Configure settings for your satellite equipment.

●● Satellite Selection : Choose one or more satelites for your product.

●● LNB Power : Enable or disable LNB Power supply from receiver.

●● LNB Settings : Configure parameters for your satelite equipment.

●● SatCR/Unicable Settings : Configure single cable installation.

"" Depending on your country, this menu function may not be supported.

●● Positioner Settings : Configure the settings for your aerial positioner.

●● Reset All Settings : Restrore all settings to defaults.
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Channel Lock  Try Now 

Prevent your children from accessing harmful content by locking channels.

When "Channel Lock" set to "on", navigate to the "Edit Channel" Screen, select the 

channels you wish to lock, select the "Lock", and then enter the PIN code. This 

locks the selected channels.

Subtitle  Try Now 

Configures the subtitle options.

Primary Subtitle Language  Try Now 

Select the Primary Subtitle language.

Secondary Subtitle Language  Try Now 

Select the Secondary Subtitle language.

Audio Language  Try Now 

Select the type of Audio Language.

Edit Channel Number
Use this to change channel number.

"" Depending on your country, this menu function may not be supported.

Primary Audio Language  Try Now 

Select the Primary Audio language.
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Secondary Audio Language  Try Now 

Select the Secondary Audio language.

Programme Rating Lock  Try Now 

Block some programmes. (Depending on the country)

"" Password : Enter the desired 4-digit password using the number buttons. 1) Belgium, 

France, Italy, Norway : You can not set the password to "0000". Please choose other 

numbers. 2) Others : Default password is set to 0000.

Data Service
Activates or deactivates the data service.

"" Depending on your country or region, this menu function may not be supported.

Digital Text
If the programme broadcasts with digital text, this feature is enabled.

"" Depending on your country or region, this menu function may not be supported.

Teletext Language  Try Now 

Set teletext language.

Primary Teletext Language  Try Now 

Select the primary teletext language.

Secondary Teletext Language  Try Now 

Select the secondary teletext language.
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RF Bypass Gain  For BD-H8500N, H8900N model 

When the TV and product are connected together with a RF cable, this function 

prevents the distortion of the broadcast signal when watching a TV channel while 

the product is powered off.

"" Power consumption will be increased when you use this function.

Aerial Connection Type  For H8509S, H8909S model 

Choose Single or Dual depending on the number of aerial cables connected.

Common Interface  Except for BD-H8500A, H8900A model 

Show common interface menu and application information.

●● CI Menu : This enables the user to select from the CAM provided menu. Select 

the CI Menu based on the menu PC Card.

●● CAM video transcoding : You can configure the setting to transcode the video 

codec from the CAM automatically. Turn it Off if you do not want to use it.

"" You must use a CAM that supports transcoding the video codec.

●● Application Info : View information on the CAM(Conditional Access Module) 

inserted into the CI. Slot and on the "CI CAM with CI or CI+ CARD" which is 

inserted into the CAM. You can install the CAM anytime whether the product 

is on or off.

●● CICAM PIN Manager : Save or clear CI CAM PIN numbers.

"" Insert the CI or CI+ card to view a paid channel. (Please refer to "Watching TV 

Channels".)
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Network
When you connect this product to a network, you can use network based 

applications and functions, and upgrade the product's software through the 

network connection. To use network services, you must connect the product to the 

network.

Network

Network Status

Network Settings	

Wi-Fi Direct	

Content Sharing	

Set Remote Access	

Device Name	 [BD]H8900

BD-Live Settings	

Network Status  Try Now 

Lets you check the current network and Internet status.

Network Settings  Try Now 

Before you begin, contact your ISP to find out if your IP address is static or 

dynamic. If it is dynamic, and you have a wired or wireless network, we recommend 

using the Automatic configuration procedures described below. 

If you are connecting to a wired network, connect the product to your router using 

a LAN cable before you start the configuration procedure. If you are connecting 

to a wireless network, disconnect any wired network connection before you begin. 

(Please refer to "Connecting to a Network Router".)
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Wired Network

Wired - Automatic

1.	 In the Home screen, select Settings, and then press the E button.

2.	 Select Network, and then press the E button.

3.	 Select Network Settings, and then press the E button.

4.	 Select Wired in the Network Settings screen, and then press the E button.

Network Settings

Select your network type.

Network type Wired

Connect

Plug a network cable into 
the back of your Blu-ray 
player.

5.	 Select the Connect, and then press the E button. The product detects the 

wired connection, verifies the network connection and then connects to the 

network.
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Wired - Manual

If you have a static IP address or the Automatic procedure does not work, you'll 

need to set the Network Settings values manually. 

Follow Steps 1 and 2 in Wired - Automatic and then follow these steps:

1.	 Select Network Status. The product searches for a network, and then displays 

the connection failed message.

2.	 On the bottom of the screen, select IP Settings, and then press the E button. 

The IP Settings screen appears.

3.	 Select the IP Setting field, and then press the E button.

4.	 Select Enter manually in the IP Setting field, and then press the E button.

5.	 Select a value to enter (IP Address, for example), and then press the E 

button. Use the number keypad on your remote control to enter the numbers 

for the value. You can also enter numbers using the ▲▼ buttons. Use the ◀▶ 

buttons on the remote control to move from entry field to entry field within a 

value. When done with one value, press the E button.

6.	 Press the ▲ or ▼ button to move to another value, and then enter the numbers 

for that value following the instructions in Step 5.

7.	 Repeat Steps 5 and 6 until you have filled in all values.

"" You can get the Network values from your Internet provider.

8.	 When finished entering all the values, select OK, and then press the E button. 

The product verifies the network connection and then connects to the network.
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Wireless Network
You can setup a wireless network connection in four ways:

–– Wireless Automatic

–– Wireless Manual

–– WPS(PBC)

–– WPS(PIN)

When you configure the wireless network connection, any wireless network devices 

currently connected through the product or, if applicable, the product's current 

wired connection, will be disconnected.

Wireless - Automatic

1.	 In the Home screen, select Settings, and then press the E button.

2.	 Select Network, and then press the E button.

3.	 Select Network Settings, and then press the E button.

4.	 Select Wireless in the Network Settings screen, and then press the E button. 

The product searches for and then displays a list of the available networks.

Network Settings

Select your network type.

Network type Wireless

Wireless network

iptime You can connect your Blu-
ray player to the internet.
Please select which wireless 
network to use.linksys3

iptime23

Refresh WPS(PBC)
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5.	 Select the desired network, and then press the E button.

6.	 On the Security screen, enter your network's Security Code or Pass Phrase. 

Enter numbers directly using the number buttons on your remote control. Enter 

letters by selecting a letter with an arrow button, and then pressing E button.

"" To view the password as you enter it, use the arrow buttons to select Show 

Password on the right side, and then press E button.

7.	 When finished, select Done and then press the E button. The product verifies 

the network connection and then connects to the network.

8.	 When verification is complete, select OK, and then press the E button.

"" You should be able to find the Security Code or Pass Phrase on one of the set up 

screens you used to set up your router or modem.

Wireless - Manual

If you have a static IP address or the Automatic procedure does not work, you'll 

need to set the Network Settings values manually.

1.	 Follow the directions in Wireless - Automatic through Step 5.

2.	 The product searches for a network, and then displays the connection failed 

message.

3.	 On the bottom of the screen, select IP Settings, and then press the E button. 

The IP Settings screen appears.

4.	 Select the IP Setting field, and then press the E button.

5.	 Select Enter manually in the IP Setting field, and then press the E button.

6.	 Select a value to enter (IP Address, for example), and then press E button. 

Use the number keypad on your remote control to enter the numbers for the 

value. You can also enter numbers using the ▲▼ buttons. Use the ◀▶ buttons 

on the remote control to move from entry field to entry field within a value. 

When done with one value, press the E button.

7.	 Press the ▲ or ▼ button to move to another value, and then enter the numbers 

for that value following the instructions in Step 6.
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8.	 Repeat Steps 6 and 7 until you have filled in all values.

"" You can get the Network values from your Internet provider.

9.	 When finished, select OK, and then press the E button. The Security Screen 

appears.

10.	 On the Security screen, enter your network's Security Code or Pass Phrase. 

Enter numbers directly using the number buttons on your remote control. Enter 

letters by selecting a letter with the ▲▼◀▶ buttons, and then pressing the E 

button.

11.	 When finished, select Done at the right of the screen, and then press the E 

button. The product verifies the network connection and then connects to the 

network.

12.	 After the product verifies the network, select OK, and then press the E button.

WPS(PBC)

1.	 In the Home screen, select Settings, and then press the E button.

2.	 Select Network, and then press the E button.

3.	 Select Network Settings, and then press the E button.

4.	 Select Wireless in the Network Settings screen, and then press the E button.

5.	 Press the ▲ button on your remote, and then press the ▶ button to select the 

WPS(PBC).

6.	 Press the E button on your remote. The "Press the PBC button on your 

wirless router within the next two minutes." message appears.

7.	 Press the WPS(PBC) button on your router within two minutes. Your product 

automatically acquires all the network settings values it needs and connects 

to your network. The Network Status screen appears. The product connects to 

the network after the network connection is verified.
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WPS(PIN)

Before you begin, open the router's setup menu on your PC and access the screen 

with the WPS PIN entry field.

1.	 In the Home screen, select Settings, and then press the E button.

2.	 Select Network, and then press the E button.

3.	 Select Network Settings, and then press the E button.

4.	 Select Wireless in the Network Settings screen, and then press the E button. 

The product searches for and then displays a list of the available networks.

5.	 Select the desired network, and then press the E button.

6.	 Select the WPS(PIN), and then press the E button. The PIN pop-up appears.

7.	 Enter the PIN into the WPS PIN entry field in the router's Set Up screen and 

then save the screen.

"" Contact the manufacturer of the router for instructions explaining how to access the 

route's Set Up screens or refer to the router's user's manual.

"" For a WPS connection, set your wireless router's security encryption method to AES. 

WPS connections do not support WEP security encryption. 
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Wi-Fi Direct
The Wi-Fi Direct function allows you to connect Wi-Fi Direct devices to the product 

and each other using a peer-to-peer network, without a wireless router.

"" Bluetooth transmissions can interfere with the Wi-Fi Direct signal. Before you use the 

Wi-Fi Direct function, we strongly recommend that you turn off the Bluetooth function 

of any active mobile device.

1.	 Turn on the Wi-Fi Direct device and activate its Wi-Fi Direct function.

2.	 In the Home screen, select Settings, and then press the E button.

3.	 Select Network, and then press the E button.

4.	 Select Wi-Fi Direct, and then press the E button. The Wi-Fi Direct devices 

that you can connect appear.

"" The wired or wireless network connection will be disconnected when you use the Wi-Fi 

Direct function.

"" Some Wi-Fi Direct devices may not support the Content Sharing function if connected 

via Wi-Fi Direct. If this is the case, it is advisable to change the network connection 

method between devices.
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Content Sharing

Multimedia Device Settings
Allow other devices on your network, like smart phones and tablets, to share 

content with your product.

Share Hard Drive
Set whether to share content from this product with other network connected 

devices, such as smart phone.

"" If this menu is set to On, Auto Power Off function is not available.

Set Remote Access
Remote access allows you to access and control your product from other devices.

You have to log in Samsung account ID to use Remote Access functions with 

Samsung product.

Register to Samsung Link
Register this device to Samsung Link to share content. Only available with 

Samsung product supporting Samsung Link functionality.
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Device Name
Lets you input a name for the product that will identify it on your networks.

BD-Live Settings  Try Now 

Set various BD-Live function. BD-Live allows you to access extra features available 

on some Blu-ray discs if you are connected to the Internet.

BD-Live Internet Connection  Try Now 

Lets you fully allow, partly allow, or prohibit a BD-Live Internet connection.

Delete BD Data  Try Now 

Once the product is connected to your network, you can enjoy various movie 

related service contents available on BD-LIVE compliant discs. By default, the 

memory is configured and requires no separate settings. If there is not enough free 

space and disturbs BD-Live operation, delete BD Data to free memory space.
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Smart Hub
Set your preferences for using Apps.

Smart Hub

Apps Settings	

VOD Rating Lock	 Off

Terms & Policy

Samsung account Terms and Conditions, Privacy Policy

Reset Smart Hub 	

Apps Settings
Lets you configure App notification settings and view basic info about your Apps.

Auto Ticker
This automatically turns on the selected ticker service.

Channel-Bound Apps
Enable or disable Channel-Bound Apps.

Channel-Bound Apps are found on certain channels and provide additional 

information or services.
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VOD Rating Lock
You can lock access to Video on Demand (VOD) content based on its rating.

"" Depending on your country, this menu function may not be supported.

"" If you haven't logged into your Samsung account, this function is not available.

Terms & Policy
You must review and agree to both the App Terms & Conditions and the privacy 

policy to use App services.

Samsung account Terms and 
Conditions, Privacy Policy
You can view and agree to the terms or privacy policy for your Samsung account 

and a variety of other services.

●● Samsung account terms & conditions

●● Samsung account Privacy Policy

●● Terms and Conditions for Recommendations

●● Recommendations Privacy Notice

Reset Smart Hub  Try Now 

Reset your App services and Samsung account settings stored on your device.
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System

System

Setup	

Language	

Device Manager	

Clock	

Storage Device Manager	

Auto Power Off	 Off

Security	

Setup  Try Now 

Sets the channels and the time when setting up this product for the first time or 

when resetting it.

Language  Try Now 

You can select the language you prefer for the On-screen menu, disc menu, etc.

"" The selected language will only appear if it is supported.

Device Manager  Try Now 

Setup input devices to use with this product. You can check your device list and 

adjust the settings in this menu.
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Keyboard Settings  Try Now 

Lets you configure a wireless USB keyboard connected to the product.

Mouse Settings  Try Now 

Lets you configure a wireless USB mouse connected to the product. You can use 

the mouse in the product's menu in the same way you use a mouse on your PC.

To use a mouse with the product's menu:

1.	 Connect the USB mouse to the product.

2.	 Click the primary button you selected in Mouse Settings. The Simple Menu 

appears.

3.	 Click the menu options you want.

"" Depending on the model of the USB HID keyboard and mouse may not be compatible 

with your product.

"" Some HID keyboard keys may not work.

"" Wired USB keyboards are not supported.

"" Some applications may not be supported.

"" If a wireless HID Keyboard does not operate because of interference, move the 

keyboard closer to the product.
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Clock  Try Now 

Sets the current date and time.

"" If Schedule Viewing and Schedule Recording is set using GUIDE, Channel List, or Info 

menu, It will work based on the time information of the TV programme. If you set the 

Clock Mode to Manual and change time manually, Schedule Viewing and Schedule 

Recording function can be limited or work abnormally.

Storage Device Manager  Try Now 

Format Device  Try Now 

Format selected device. All contents will be deleted from that device.

Check Device  Try Now 

Check to see if there is an error with the selected device.

Device Performance Test  Try Now 

Test the recording performance of the device.

"" Since the product's Timeshift and other implemented functions require a certain 

amount of HDD space allocated internally, the total size shown in the Storage Device 

Manager of Settings menu may differ from the HDD's capacity shown in the manual.
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Select Device for Recording
Change the location of where you store recorded files.

Auto Power Off  Try Now 

Saves power by turning off your product automatically when no user operation is 

received for setting time(4hours, 6hours, 8hours).

"" This function isn't available when Share Hard Drive is set to On.

Security  Try Now 

This function works in conjunction with Blu-ray Disc/DVDs that have been assigned 

an age rating or numeric rating that indicates the maturity level of the content.

These numbers help you control the types of Blu-ray Disc/DVDs that your family 

can watch. When you access this function, the security screen appears.

Enter the your Security PIN.

"" Password : Enter the desired 4-digit password using the number buttons. 1) Belgium, 

France, Italy, Norway : You can not set the password to "0000". Please choose other 

numbers. 2) Others : Default password is set to 0000.

BD Parental Rating
Prevent playback of Blu-ray Discs with specific age ratings unless a PIN is entered.

DVD Parental Rating
Prevent playback of DVDs with specific numerical ratings unless a PIN is entered.

A larger number indicates that the programme is intended for adult use only.

Change PIN
Change the 4-digit PIN used to access security functions.
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General  Try Now 

You can change the options listed below to match your preferences.

Advanced Music Copy  Try Now 

When you copy music files, information can be updated automatically.

The copying time may be increased.

"" This feature is available only when the product is connected to the network.

Menu Transparency  Try Now 

Adjust the transparency of the menu box.

Anynet+ (HDMI-CEC)  Try Now 

Anynet+ is a convenient function that offers linked operations with other Samsung 

products that have the Anynet+ feature. To operate this function, connect this 

product to an Anynet+ Samsung TV using an HDMI cable.

DivX® Video On Demand  Try Now 

View DivX® VOD Registration Codes to purchase and play DivX® VOD contents.
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Support

Support

Remote Management	

e-Manual	

Software Update

Contact Samsung	

Reset

Remote Management  Try Now 

Remote management lets our Call Centre access your Samsung product remotely 

to troubleshoot a problem.

e-Manual
Check the E-manual stored in the device to get troubleshooting tips.

Software Update  Try Now 

The Software Update menu allows you to upgrade the product's software for 

performance improvements or additional services.

1.	 In the Home screen, select the Settings, and then press the E button.

2.	 Select Support, and then press the E button.

3.	 Select Software Update, and then press the E button.
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4.	 To download update software and update now, select Update Now, and then 

press the E button.

5.	 To let the product download update software automatically when available, 

select Auto Update, and then press the E button. 

"" The upgrade is complete when the product turns off, and then turns on again by itself.

"" Samsung Electronics shall takes no legal responsibility for product malfunction caused 

by an unstable Internet connection or consumer negligence during a software Update.

"" When a system upgrade is in progress, "UPDATE" is displayed on the front panel.

Update Now
You can use Update Now to update the software through your network connection 

or by using a USB flash drive. The network instructions are below. The USB flash 

drive instructions are on the next page.

1.	 Select Update Now, and then press the E button. The Update now pop-up 

appears.

2.	 The product searches on line for the latest software version.

3.	 If it does not find an update, the "There are no new updates for you at the 

moment." pop-up appears. Press the E button to exit.

4.	 If it finds a new version, the Update Request pop-up appears.

5.	 Select OK. The product upgrades the software, turns off, and then turns on 

automatically.

6.	 If you select Cancel, the product cancels the upgrade.

"" When the system upgrade is done, check the software details in the Product 

Information section of the Contact Samsung screen.

"" Do not turn off the product during the Software Update. It may cause the product to 

malfunction.
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Auto Update
You can set the Auto Update function so that the product downloads new upgrade 

software when it is in Auto Update mode. In Auto Update mode, the product is off, 

but its Internet connection is active. This allows the product to download upgrade 

software automatically, when you are not using it.

1.	 Press the ▲▼ buttons to select Auto Update, and then press the E button.

2.	 Select "Off" or "On".

●● On : The product will proceed with updating its software automatically if a new 

release of the software becomes available without notifying the user.

●● Off : The product will prompt user to confirm updating when a new release 

of the software becomes available, which allows user to proceed or cancel 

updating.

"" To use the Auto Update Mode Upgrade function, your product must be connected to 

the Internet.

Manage Satellite Channels  For BD-H8509S, H8909S model 

Manage software downloads via a satellite channel.

Update by USB
To upgrade by USB, follow these steps:

1.	 Visit www.samsung.com.

2.	 Click SUPPORT on the top right of the page.

3.	 Enter the product's model number into the search field. As you enter the model 

number, a drop down will display products that match the model number.

4.	 Left click your product's model number in the drop down list.

5.	 On the page that appears, scroll down to and then click Firmware Manuals & 

Downloads.

6.	 Click Firmware in the centre of the page.

7.	 Click the ZIP button in the File column on the right side of the page.

8.	 Click Send in the first pop-up that appears. Click OK in the second pop-up to 

download and save the firmware file to your PC.
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9.	 Unzip the zip archive to your computer. You should have a single folder with 

the same name as the zip file.

10.	 Copy the folder to a USB flash drive.

11.	 Make sure no disc is inserted in the product, and then insert the USB flash 

drive into the USB port of the product.

12.	 In the product’s menu, go to Settings > Support > Software Update.

13.	 Select Update Now.

14.	 The product searches for the software on the USB drive. When it finds the 

software,the Update Request pop-up appears.

15.	 Select OK. The product upgrades the software, turns off, and then turns on 

automatically.

"" There should be no disc in the product when you upgrade the software using the USB 

jack.

"" When the system upgrade is done, check the software details in the Product 

Information section of the Contact Samsung screen.

"" Do not turn off the product during the Software Update. It may cause the product to 

malfunction.

"" Software Updates using the USB jack must be performed with a USB flash memory 

stick only.

Contact Samsung  Try Now 

Provides contact information for assistance with your product.

Reset  Try Now 

Resets all settings to their default settings except for the network and App service 

settings. The default PIN is 0000.

"" Password : Enter the desired 4-digit password using the number buttons. 1) Belgium, 

France, Italy, Norway : You can not set the password to "0000". Please choose other 

numbers. 2) Others : Default password is set to 0000.
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Your product can play content located on Blu-ray/DVD/CD discs, USB devices, 

and PCs. To play content located on your PC, you must connect your PC and the 

product to your network and Visit the http://link.samsung.com site to download 

and install the Samsung-link program.

Playing Commercial Discs
1.	 Press the  button to open the disc tray.

2.	 Place a disc gently into the disc tray with the disc’s label facing up. 

3.	 Press the  button to close the disc tray. Playback starts automatically.

"" In TV view mode, the ∂ button will function as Timeshift rather than its original 

function, playback even if there is a disc inserted.

"" In Home screen, the ∂ button will function as playback of multimedia content in the 

disc.

Media Play
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Playing Photos, Videos, and 
Music (Multimedia)
You can play media content saved on a USB device, built-in HDD, smartphone, 

camera, computer, or cloud service on the product.

"" However, you cannot play media content if the content or the storage device are not 

supported by the product.

"" Backup important files before connecting a USB device. Samsung shall not be held 

responsible for damaged or lost files.

Playing Media Content Saved on a 
USB Device
1.	 Connect your USB device to the product.

2.	 Press the HOME button and select Storage in the Multimedia panel. The USB 

devices connected to the product are listed.

3.	 Select the device you wish to connect to. The folders and files in the selected 

USB are listed.

4.	 Select the media content you wish to play from the list. The media content 

plays.

"" Alternatively, move to the media content to play and press the ∂ button to play the 

content.

5.	 To exit, press the ∫ button or RETURN button.

"" If you connect a USB device to the product while watching the product, a popup 

window appears on the screen so that you can easily navigate the folders and files of 

the USB device.
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Playing Media Content Saved in a 
Computer/Mobile Device
You can play media content on the product with a computer or mobile device 

connected to the same network as the product.

"" Only available with Samsung phones supporting DLNA functionality.

"" Samsung Link software should have been installed on the computer. The mobile device 

should support Samsung Link. For more information, visit Samsung’s content and 

service portal at http://link.samsung.com.

"" You may experience compatibility issues when attempting to play media files via a 

third-party DLNA server.

"" However, the content shared by a computer or a mobile device may not play depending 

on the encoding type and file format of the content. In addition, some functions may 

not be available.

"" The media content may not smoothly play depending on the network status. If this is 

the case, use a USB storage device.

1.	 Connect the smart device and product.

2.	 Press the HOME button. (Settings → Network → Content Sharing → 

Multimedia Device Settings) Storages devices connected to the same network 

of the product are listed.

3.	 Select a desired storage device. The folders and files shared by the selected 

storage device are listed.

4.	 Select the media content you wish to play from the list. The media content 

plays.

"" Alternatively, move to the media content to play and press the ∂ button to play the 

content.

5.	 To exit, press the ∫ button or RETURN button.
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Allowing Connection with a Mobile Device
(HOME → Settings → Network → Content Sharing)

To play the media content stored on a mobile device, you must allow the 

connection between the mobile device and the product.

"" You can connect to a mobile device on any DLNA DMC device. DLNA DMC function 

enables users to connect a mobile device to the product, search for media content, and 

control play operations on the product.

1.	 Navigate to Settings > Network and select Content Sharing. The mobile 

devices connected to the same network as the product are listed.

2.	 Allow connection with the device you wish to connect to the product. You can 

only play media files from devices that have been allowed to connect to the 

product.

"" If a mobile device requests the media content to play, the connection confirmation 

window appears on the product so that you can easily connect a mobile device.
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Playing Media Content Saved 
in a Cloud Service
Cloud service saves user content such as photos, videos, and music files on a 

server so that it can be played on the product connected to the network. You can 

view the media content saved in a cloud service such as Dropbox and OneDrive on 

the product.

"" To play the content in a cloud service, you must log into your Samsung account and 

link the Samsung account to the cloud service account. For the information about 

linking your Samsung account to a cloud service account, refer to "Linking Your 

Internet Service Accounts to the product" section.

1.	 Press the HOME button and select Cloud Service in the Multimedia panel. The 

cloud services linked with your Samsung account appears.

2.	 Select a desired cloud service. The folders and files in the selected cloud 

service are listed.

3.	 Select media content you wish to play from the list. The media content plays.

"" Alternatively, move to the media content to play and press the ∂ button to play the 

content.

4.	 To exit, press the ∫ button or RETURN button.

"" A Samsung smart device or a PC installed with the Samsung Link app can be 

connected to the Blu-ray product through a remote network.

"" To connect devices through a remote network, the same Samsung Account should be 

used to log in for both this Blu-ray product and the device running the Samsung Link 

app.

"" For further details on sharing contents with Samsung Link in remote access network, 

refer to the "Register to Samsung Link" guide to enable the function.

"" For more information, visit the Samsung Content & Service portal (http://link.samsung.

com).
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Samsung Link
For more information, visit the Samsung Content & Service portal (http://

link.samsung.com).

"" You may experience compatibility issues when attempting to play media files via a 

third-party DLNA server.

Controlling Video Playback
You can control the playback of video content located on a Disc, USB, mobile 

device or PC. Depending on the disc or contents, some of the functions described 

in this manual may not be available.

Buttons on the Remote Control used 
for Video Playback

Playback related buttons

The product does not play sound in Search, Slow or Step mode.

●● To return to normal speed playback, press the ∂ button.

●● ∂ button : Starts playback.

●● ' button : Stops playback.

●● ∑ button : Pauses playback.
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●● Fast Motion Play : During playback, press the † or … button. Each time you 

press the † or … button, the playback speed will change.

●● Slow Motion Play : In pause mode, press the … button. Each time you press the 

… button, the playback speed will change.

●● Step Motion Play : In pause mode, press the ∑ button. Each time you press the ∑ 
button, a new frame appears.

●● Skip Motion Play : During playback, press the € or ‚ button. Each time you 

press € or ‚ button, the disc moves to the previous or next chapter or file.

Using the disc menu, title menu, popup menu, and title list

●● DISC MENU button : During playback, press this button to display the Disc 

menu.

●● TITLE MENU button : During playback, press this button to display the Title 

menu.

"" If your disc has a playlist, press the View button to go to the playlist.

●● POPUP MENU button : During playback, press this button to display the Popup 

menu.
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Using the Settings Menu (During the 
Playback)
During playback or in pause mode, press the TOOLS button.

Use the ▲▼◀▶ buttons to select the  button, and then press the E button.

●● Play from the beginning : Select to return to the beginning of the movie, and 

then press the E button

●● Select Scene

–– Search Titles : If there is more than one movie on the disc or device, select 

to start a different title.

1.	 Select Search Titles, and then press the E button.

2.	 Use the ▲▼ buttons to select a title, and then press the E button.

–– Chapter Search : Select to play the chapter of your choice.

1.	 Select Chapter Search, and then press the E button.

2.	 Use the ▲▼ buttons to select a chapter, and then press the E button.

–– Search Time Bar : Select to play the movie from a selected time point.

1.	 Select Search Time Bar, and then press the E button.

2.	 Using the number buttons, enter the time point you want to go to, and then 

press the E button.

"" You can also use the ◀▶ buttons to advance or rewind the movie. The movie 

advances or rewinds one minute each time you press the ◀▶ buttons.

"" If the index information in the file is damaged or the file does not support indexing, 

you will not be able to use the Select Scene function.

"" If you run files on network device after you have connected the player to a computer 

on your network, Select Scene may not work.

●● 3D : Use the 3D menu when playing a 3D file.

"" The 3D menu becomes available only when you are playing a 3D video file.

"" When playing a 3D video, set the player to Side by Side or Top and Bottom in 3D 

Settings so that the player's settings match the 3D content format.

"" If you move to the Home or Smart Hub Home screen while in 3D mode, the product 

will switch to 2D automatically.
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●● Search

–– Search Scene : You can use the Search Scene function during playback to 

view or start a movie from the scene of your choice.

–– Search Titles : If there is more than one movie on the disc or device, select 

to start a different title.

–– Search Time Bar : Select to play the movie from a selected time point. 

●● Subtitle Settings : Lets you set the desired subtitle options.

●● Repeat Mode : Lets you repeat a title, chapter, or specific section.

●● Rotate : Lets you rotate the picture.

●● Full Screen : Lets you set the size of the video image.

●● Picture Mode : Lets you set the picture mode.

–– Dynamic : Increases sharpness and brightness.

–– Standard : Choose this setting for most viewing applications.

–– Movie : The best setting for watching movies.

–– User : Lets you adjust the sharpness and noise reduction function 

respectively.

"" When you use the BD wise function, this menu will not appear.

●● Audio : Use to set the desired audio language.

●● Audio Sync : Select to set the audio sync.

●● Subtitle : Use to set the desired subtitle language.
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●● Angle : Lets you view a scene from another angle. The Angle option displays 

the number of angles available to view. When a Blu-ray Disc/DVD contains 

multiple angles of a particular scene, you can change angle.

●● Information : Lets you to view video file information.

●● BONUSVIEW Video, BONUSVIEW Audio : Use to set the desired bonusview 

option.

"" Depending on the disc or storage device, the Settings menu may differ. 

"" Video files with high bitrates of 20Mbps or more strain the product's capabilities and 

may stop playing during playback.

Using the View & Options Menus

Using the View Menu
On a file screen containing video files, select  and then press the E button.

●● Date : Groups all the the photo files on the media or storage device by date. 

Click a group to see the videos in that group.

●● Title : Displays all the video files on the media or storage device by title.

●● Folder : Displays all the folders on the media or storage device in alphabetical 

order.

"" Depending on the disc or storage device, the View menu may differ or not appear.
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Using the Options Menu
On a file screen containing video files, select  and then press the E button.

●● Play Selected : Play Selected lets you select specific file to play. It works 

essentially the same for all media.

●● Send : Select Send to upload selected files to a web site (Picasa, Facebook etc) 

or device. To use Send, you need to establish an account with the on-line site, 

and then log in using the Log In function.

Controlling Music Playback
You can control the playback of music content located on a Disc, USB, mobile 

device or PC.

Depending on the disc or contents, some of the functions described in this manual 

may not be available.
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Buttons on the Remote Control used 
for Music Playback

●● NUMBER buttons : Press the number of a track. The selected track is played.

●● € ‚ button : Move to the previous/next track.

●● ' button : Stops a track.

●● Fast Play (Audio CD (CD-DA) only) : During playback, press the † or … button. 

Each time you press the † … button, the playback speed will change.

●● ∑ button : Pauses a track.

●● ∂ button : Plays the currently selected track.

"" If you don't press a button within five seconds of inserting an Audio CD, the screen is 

displayed in Full Screen mode. To go back to the Play List screen, press the RETURN 

button on the remote control.

Using the Options Menu (During the 
Playback)
On the music file playback screen, use the ▲▼◀▶ buttons to select the  button, 

and then press the E button.

●● Save as playlist : Select to save as playlist.

●● Play Selected : Play Selected lets you select specific tracks to play. It works 

essentially the same for all media. See the "Repeating tracks on an Audio CD".

●● Ripping : The Ripping function converts CD audio to the mp3 format and saves 

the converted files on a USB device or a mobile device connected to the 

product. 

●● Information : Select to see the (Contents) information.

"" Depending on the disc or storage device, the Settings menu may differ or not appear.
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Using the View & Options Menus (On 
a file screen)

Using the View Menu
On the playback screen,  button and then press the E button.

●● Track : Displays all the music tracks on the media or storage device in 

alphabetical order.

●● Album : Displays all music on the media or storage device by album.

●● Artist : Displays all the the music files on the media or storage device by artis.

●● Genre : Displays all the music on the media or storage device by genre.

●● Folder : Displays all the folders on the media or storage device.

"" Depending on the disc or storage device, the View menu may differ or not appear.

Using the Options Menu
On playback screen or a file screen containing music files, select  and then press 

the E button.

●● Play Selected : Play Selected lets you select specific tract to play. It works 

essentially the same for all media. See the "Repeating tracks on an Audio CD".

●● Send : Select to send selected files to other devices.

●● Encoding : Select to manage the text encoding options.

"" Depending on the disc or storage device, the Options menu may differ or not appear.
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Repeating Tracks on an Audio CD
You can set the product to repeat tracks on an audio CD (CD-DA/MP3).

1.	 On the Playback screen, use the ▲▼◀▶ buttons to select  in the lower left 

corner of the screen, and then press the E button.

2.	 Use the ▲▼ to select the repeat mode you want - Off, One Song, or All - and 

then press the E button.

Off

One Song

All

Shuffling Tracks on an Audio CD
You can set the product to play tracks on an audio CD (CD-DA/MP3) at random.

1.	 On the Playback screen, use the ▲▼◀▶ buttons to select  in the lower left 

corner of the screen, and then press the E button.

2.	 Use the ▲▼ to set the Shuffle mode On or Off, and then press the E button.
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Creating a Playlist from an Audio CD
1.	 With the Playback screen displayed, select the  button and then press the 

E button. The Settings menu appears.

2.	 Use the ▲▼ buttons to select Play Selected, and then press the E button. 

The Selection Play screen appears.

3.	 Use the ▲▼ buttons to select a track, and then press the E button. A check 

appears to the left of the track.

4.	 Repeat Step 3 to select and check additional tracks.

5.	 To remove a track from the list, move to the track, and then press the E 

button again. The check on the track is removed.

6.	 When done, press the ▲▼ button to select Play, and then press the E button. 

The Music Playback screen reappears listing only the tracks you checked. The 

selected tracks play automatically.

"" You can create a playlist with up to 99 tracks on Audio CDs (CD-DA).

"" If you have created a playlist, Play Selected is replaced by Edit Playlist on the Settings 

menu.

"" On the Selection Play screen, you can also choose Select All, Clear All, and Cancel. 

1) Use Select All to select all tracks. This cancels your individual track selections. 

When you press the RETURN button on your remote control or select Play button, and 

then press the E button, all tracks will appear on the Music Playback screen, and the 

product will begin to play all tracks from Track 001. 2) Use Clear All to deselect all 

selected tracks at once. Then, select individual tracks or use Select All to select all the 

tracks, and then press the RETURN button on your remote control. If you do not use 

Select All or select individual tracks, the Playlist will not change. 3) Cancel cancels any 

changes you made on the Play Select screen. When you return to the Playback screen, 

the Playlist will be unchanged.
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Ripping
1.	 Insert a USB device into the USB jack on the front of the product.

2.	 With the Playback screen displayed, select the  button and then press the 

E button. The Settings menu appears.

3.	 Use the ▲▼ buttons to select Ripping, and then press the E button. The 

Ripping screen appears.

4.	 Use the ▲▼ buttons to select a track, and then press the E button. A check 

appears to the left of the track.

5.	 Repeat Step 3 to select and check additional tracks.

6.	 To remove a track from the list, move to the track, and then press the E 

button again. The check on the track is removed.

7.	 When done, select the Rip button using the ▲▼ button, and then press the E 

button. The Rip pop-up appears.

8.	 Use the ▲▼ buttons to select the device to store the ripping file and then 

press the E button.

"" Do not disconnect the device while rip is in progress.

9.	 If you want to cancel ripping the track, press the E button and then select 

Yes. Select No to continue ripping.

10.	 When ripping is complete, the "Successfully ripped." message appears. Press 

the E button.

11.	 Press the RETURN or select the Cancel button and then press the E button to 

go back to the Playback screen.

"" This function does not work with DTS Audio CD.

"" This function may not be supported by some discs.

"" This function will be encoded into the .mp3 format at 192kbps.

"" On the Ripping screen, you can also choose Select All and Clear All.

"" Use Select All to select all tracks and press the E button. This cancels your individual 

track selections. 

"" Use Clear All to deselect all selected tracks at once.
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Playing Photo Contents
You can play photo contents located on a DVD, USB, mobile device or PC. 

Using the Tools Menu (During Playback)
During playback or in pause mode, press the TOOLS button.

Use the ▲▼◀▶ buttons to select the  button, and then press the E button.

●● Slideshow Settings : Select to change the Slide Show settings.

–– Speed : Select to set the slide show speed.

–– Effect : Select to set the slide show effect.

●● Rotate : Select to rotate the picture. (This can rotate the picture either clockwise 

or counter clockwise.)

●● Zoom : Select to enlarge the current picture. (Enlarge up to 4 times)

●● Picture Mode : Select to set the picture mode.

–– Dynamic : Choose this setting to increase Sharpness.

–– Standard : Choose this setting for most viewing applications.

–– Movie : This is the best setting for watching movies.

–– User : Lets you adjust the sharpness and noise reduction function 

respectively.

"" This menu can not be displayed when you use the BD Wise function.

●● Background Music : Select to listen to music while viewing a slide show.

"" The number of music files searched from the external device may differ from 

devices.

●● Send : Select to send the selected file to other devices.

●● Information : Select to see the (Contents) information.

"" Depending on the disc or storage device, the Tools menu may differ. All options may 

not be displayed.

"" To enable the background music function, the photo file must be in the same storage 

media as the music file. Note that the sound quality can be affected by the bitrate of 

the MP3 file, the size of the photo, and the encoding method.

"" You can't enlarge the subtitle and PG graphic in the full screen mode.
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Using the View & Options Menus

Using the View Menu
On a file screen containing photo files,  button and then press the E button.

●● Date : Groups all the the photo files on the media or storage device by date. 

Click a group to see the photos in that group.

●● Title : Displays all the photo files on the media or storage device by title.

●● Folder : Displays all the folders on the media or storage device.

"" Depending on the disc or storage device, the View menu may differ or not appear.

Using the Options Menu
On a file screen containing photo files, select the  and press the E button.

●● Slide show : Starts the slide show. Shows all the files in the current folder, 

one after another. If you want to create a slide show with a selected group of 

photos, see Play Selected below.

●● Play Selected : Play Selected lets you select specific photo to see. It works 

essentially the same for all media.

●● Send : Select Send to upload selected files to a web site (Picasa, Facebook etc) 

or device. To use Send, you need to establish an account with the on-line site, 

and then log in using the Log In function.
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Watching TV Channels
After Tuning is completed, you can watch TV channel.

(Please refer to "Broadcasting" to search channel.)

Using the channel option

Using the remote control buttons
Press the below buttons while you are viewing a channel.

●● NUMBER buttons : To move TV channel directly, press the channel numbers of 

desired TV channel.

●● PROG button : Press this button to change TV channels.

●● INFO button : Press this button to display detailed information of selected 

channel.

●● CH LIST button : Press this button to display the Channel List.

DTV Functions
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Using the Tools Button
Press the TOOLS button while you are viewing a channel.

●● Picture Mode : Select this to set the picture mode.

–– Dynamic : Choose this setting to increase Sharpness.

–– Standard : Choose this setting for most viewing applications.

–– Movie : This is the best setting for watching movies.

–– User : Lets you adjust the sharpness and noise reduction function 

respectively.

"" This menu can not be displayed when you use the BD Wise function.

●● Audio Sync : Adjust the audio delay time to match the video.

●● Audio Language : Select to set the desired audio language.

●● Dual I II : Select to set the desired audio.

●● Lock Current Channel : You can lock a TV channel by setting PIN.

"" This menu can be displayed when the country set to Netherlands and brodcast 

signal is cable.

●● Aerial : Select to change a signal.

●● Edit Favourites : Select to edit Favourites.

●● Signal Information : Select to check the signal information.

●● Audio Description : Select to add a verbal description to the main audio to help 

the visually impaired.

●● Subtitle : Select to set the desired subtitle.
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Watching Pay chan-
nels  Except for BD-H8500A, H8900A model 

To watch a paid channel, the CI or CI+ card must be inserted.

After channel tuning is completed, follow the instructions.

1.	 Purchase a CI CAM at your nearest dealer or by phone.

2.	 Firmly insert the "CI CAM with CI or CI+ CARD".

3.	 Insert the CAM with the "CI CAM with CI or CI+ CARD" into the common 

interface slot, in the direction of the arrow so that it aligns parallel with the 

slot.

4.	 Check if you can see a picture on a scrambled signal channel.

"" This product works with CI and CI+ CAM. But in case of some local broadcasting 

operators, this product may not have perfect compatibility with all kinds of CAM.

"" If the inserted CAM does not operate properly, pull the CAM CARD out of the 

product and insert it into the slot again.

"" If a popup message appears, please take a step referring the follows.(This is not a 

product malfunction. Please contact your service provider for more information.)

1.	 "Wrong smart card inserted." : Smart card is inserted incorrectly.

2.	 " Inserted smart card not supported." : Wrong smart card is inserted.

3.	 "The credit of your smart card has expired. Your smart card is not authorised 

for this service." : The credit of your smart card has expired.

4.	 "No smart card is inserted." : Smart card is not inserted correctly.

"" Some CAM in the market with older firmware versions are not fully interoperable 

with this device that is compliant to v1.3 specification. 

"" It is a problem of legacy CAM, not this CI Plus compliant device. In this case, this 

problem can be resolved by applying a firmware upgrade to the CAM.

"" Please contact your network operator or CAM operator for it.

"" Check whether the firmware of CAM is upgraded for compatibility with CI+ 1.3 

Version.

"" For more information on "CI CAM with CI or CI+ CARD", refer to the "Common 

Interface".
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Channel List
1.	 Press the CH LIST button on the remote control to see all channels searched. 

The Channel List will be displayed.

2.	 Press the ◀ button to sort channels. You can change the list ordered. (Aerial, 

Category, Sorting, Genre, Edit Favourites)

Edit Channel
You can manage the stored channels.

(HOME → Settings → Broadcasting → Edit Channel)

1.	 In the Home screen, select Settings, and then press the E button.

2.	 Select Broadcasting, and then press the E button.

3.	 Select Edit Channel, and then press the E button. The Edit Channel Screen 

will be displayed.
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Using the remote control buttons
When the Edit Channel Screen is displayed, you can manage the stored channels.

●● Change Number : Select this to change the channel number.

●● Lock / Unlock : Select this to lock or unlock channels.

●● Delete : Select this to deletes selected channel.

●● Options

–– Select All : Select this to check all channels.

–– Deselect All : Select this to deselect all channels.

–– Sorting : Select this to sorting channels.

–– Category : Select this to display category.

–– Edit Favourites : Select this to edit favourites

–– Channel Info : Select this to display channel Info.

–– Information : Select this to displayI nformation.
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EPG & Schedule Manager
The EPG (Electronic Programme Guide) information is provided by broadcasters. 

Using channel schedules provided by broadcasters, you can specify channels 

you want to watch in advance so that the channel automatically changes to the 

selected channel at the specified time. Channel entries may appear blank or out of 

date depending on a channel status.

Using the Guide Screen option
1.	 Press the GUIDE button on the remote control.

2.	 To display the popup for channel number input, press a number button while a 

channel is selected.

3.	 Input the desired channel, and then press the E button to go to channel guide.

4.	 Select a program.

5.	 Select Schedule Recording or Schedule Viewing, and then press the E button.

"" If you set the country to New zealand, the guide screen is provided by digital 

broadcasts. So, Guide screen is different from above.

Setting the Schedule Manger manually
You can reserve the desired TV programmes using this menu. Make sure that clock 

must be set before operating this function.

(Home → Schedule Manager → Schedule Viewing / Schedule Recording)

1.	 Select Schedule Manager on the Home screen, and then press the E button.

2.	 Press the E button.

3.	 Select Schedule Recording  or Schedule Viewing , and then press the E 

button.

4.	 Fill the input items, and then press the E button.
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Using the Teletext Service
If DTV programme supports teletext signal, you can use teletext service. For 

Teletext information is displayed correctly, channel reception must be stable. 

Otherwise, information may be missing or some pages may not be displayed.

1.	 Press TTX/MIX button while you are viewing a TV channel.

2.	 By pressing the TTX/MIX button repeatedly, you can change or exit the 

teletext mode. 

●● 8 : Stores the Teletext pages.

●● 4 : Displays the teletext on the upper half of the screen in double-size. To 

move the text to the lower half of the screen, press it again. For normal 

display, press it once again.

●● 9 : Holds the display at the current page, in the case that there are several 

secondary pages that follow automaticially. To undo, press it again.

●● Colour buttons (red, green, yellow, blue) : If the FASTEXT system is used by 

the broadcasting company, the different topics on a Teletext page are colour-

coded and can be selected by pressing the coloured buttons. Press the colour 

corresponding to the topic of your choice. A new colour-coded page is 

displayed. Items can be selected in the same way. To display the previous or 

next page, press the corresponding coloured button.

●● 1 : Displays the available sub-page.

●● 2 : Displays the next Teletext page.

●● 3 : Displays the previous Teletext page.

●● 6 : Displays the index (contents) page at any time while you are viewing 

Teletext.

●● 0 : Selects the Teletext mode (LIST/ FLOF). If pressed during LIST mode, 

switches the mode to List savemode. In List save mode, you can save a 

Teletext page into a list using the 8(store) button.

●● 5 : Displays the hidden text (answers to quiz games, for example). To display 

the normal screen, press it again.

●● 7 : Shrinks the Teletext display to overlap with the current broadcast.

https://manualsfile.com


80

Typical Teletext page

Part Contents

A Selected page number.

B Broadcasting channel identity.

C Current page number or search indications.

D Date and time.

E Text.

F Status information. FASTEXT information.

"" Teletext TTX/MIX control is available only when the DTV programme support teletext 

signal.
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Recording

Checking Available Storage Size
Please check the default recording device and available storage size in storage 

device for recording. (please refer to "Storage Device Manager".)

"" At least 100 MB of free space is required for recording.

"" Recording will stop if the storage's free space becomes less than 50 MB.

Notes on HDD capacity
This product reserves HDD capacity internally as described below, for function 

implementations and this reserved portion is not used for recording. (Timeshift : 22 

GB, Functional Purpose : 5 GB)

The displayed capacity on OSD which shows approximated available capacity for 

recording is shown below, calculated based on shipped status.

Model Name HDD Vendor Specification

BD-H89 series 1 TB

BD-H85 series 500 GB

"" Display of HDD Capacity : The Capacity of the HDD manufacturer is calculated 

assuming that 1 KB = 1,000 Bytes. However, the operating system of the product 

calculates the capacity of HDD capacity assuming that 1 KB=1,024 Bytes, and therefore 

detected capacity by this product is about 93% of HDD Manufacturer representation. 

E.g. for a 1 TB(1000 GB) HDD, this product detect as 931.3 GB.

"" It is recommended to use recorded or edited files with the product for private purposes 

only.

Advanced Function
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Recording the current TV channel 
you are watching
1.	 Press the PROG or number buttons to select a TV Channel you want to record.

2.	 Press the REC button.

3.	 Select the desired length of the recording, then press the E button.

"" Maximum length of one recording is limited to 360 minutes. If recording reached the 

limit of 360 minutes, it will stop automatically.

To pause recording

1.	 Press the REC PAUSE button to pause a recording in progress.

2.	 Press the REC button to resume recording.

To stop recording
Press the ' button to stop a recording in progress.

Playback control during recording
During recording a TV channel, you can search scene or move to the beginning 

point of recording without influence on the recording through Timeshift function.

1.	 † … buttons : Search the desired scene. Each time this button is pressed, 

playback speed will change.

… 1 → … 2 → … 3 → … 4 → … 5

† 1 → † 2 → † 3 → † 4 → † 5 

2.	 € button : Return to the beginning point of recording.

3.	 ‚ button : Jump to the same scene with Live TV.

4.	 l button : Jump to - 10 sec from current position.

5.	 r button : Jump to + 10 sec from current position.
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6.	 ∑ button : Pause the scene while keeping recording progress.

7.	 ' button : If you are watching the past scene, the playback point will jump 

to the same scene with Live TV. If you are watching same scene with Live TV, 

recording will be stopped.

Watching other channels during Recording a 
TV channel
While a TV programme is being recorded, you can also watch TV channels. During 

the recording, press the PROG or number buttons to change the channel you want 

to watch.

"" You can watch a free or scrambled channel while recording a free TV channel. If you 

are recording a scrambled channel, only a free channel can be watched.

"" Recorded files of less than 10 seconds are not saved.

Simultaneous Recording

Simultaneous Recording of Two TV Channels

1.	 While a TV channel is being recorded, move to other TV channel that you want 

to record.

2.	 Press the REC Button. The recording will be started.

"" Recording two different paid channels at the same time is not supported.

"" If you want to enjoy simultaneous Recording of two TV channels, you need to connect 

satellite RF cables to ANT1 IN and ANT2 IN.  For H8509S, H8909S model 

"" Even if you connect two CI(+) CAM to CAM slot, you can not view or recording two 

paid channels Simultaneously.  For H8509S, H8909S model 
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Watching different TV channels that is not 
under recording
You can watch yet another channel while recording two TV channels at the same 

time.

1.	 Press the CH LIST button to check which TV channel is possible to watch. Blue 

coloured TV Channel in Channel List is what you can move without stopping 

the recordings already started.

2.	 Press the E button to watch the possible TV Channel. To watch a channel that 

is not displayed in Blue, you need to stop at least one of currently recording.

To stop recording

If you are watching a TV channel which is under recording

Press the ' button.

If you are watching a TV channel which is not under recording

Press the ' button.

Simultaneous Operation
You can play a disc or enjoy other function during recording. Press the HOME 

button, and then select the SAMSUNG APPS or MULTIMEDIA. But, you can not 

select the settings menu unless stop the recording.
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Timeshift function
You can pause a live TV or start watching the TV programme from the beginning 

point you started Timeshift function.

Start Timeshift with PLAY button

1.	 When you are watching a TV channel, press the ∂ button.

2.	 The Timeshift function starts and the Timeshift bar will appear. Live TV is 

displayed on the left side of Timeshift bar.

Start Timeshift with PAUSE button

1.	 When you are watching a TV channel, press the ∑ button.

2.	 The image of TV programme will be paused, and then Timeshift bar will 

appear. ∑ (Pause) is displayed on the left side of Timeshift bar.

Timeshift information
You can see current information about Timeshift function.

1.	 Press the E button on your remote control while Timeshift function is 

enabled.

2.	 Timeshift bar appears as below.

"" The Timeshift settings are sustained even when you switch to another channel in 

Timeshift operation. In this case, Timeshift of former channel is supported as history 

function. (The Timeshift of former channel is still available) 

"" If Timeshift is started with Play or Pause key, the Timeshift is sustained until the Stop 

button is pressed. In case when the Timeshift operation becomes not available (such 

as switching to another application, an analogue channel or changing the input source), 

Timeshift stops without a notification and will resume automatically as soon as the 

source is switched to Digital TV. 1) The history function supports only for records of 

switching within channels of Digital TV source. 2) If switched to an analogue channel, 

history and Timeshift will stop functioning automatically. 3) Timeshift automatically 

stops when selected another menu in the Home menu. (Stops Timeshift and history 

functions that were operating.) 4) Returning to a Digital TV channel will automatically 

resumes Timeshift, if not accessed any other menu item of the Home menu. 

"" For Timeshift function, 22 GB of the internal HDD is reserved.
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Playback control button during Timeshift 
function is enabled

1.	 † … buttons : Search the desired scene. Each time this button is pressed, 

playback speed will change.

… 1 → … 2 → … 3 → … 4 → … 5 

† 1 → † 2 → † 3 → † 4 → † 5 

2.	 € button : Return to the beginning of Timeshift.

3.	 ‚ button : Shows same scene with Live TV.

4.	 l button : Jump to - 10 sec from current position.

5.	 r button : Jump to + 10 sec from current position.

6.	 ∑ button : Pause the scene while keeping Timeshift operation.

7.	 ' button : If you are watching the past scene, playback point will jump to the 

same scene with Live TV. If you are watching the same scene with Live TV, the 

Timeshift function will be stopped. 

To stop Timeshift

1.	 If Timeshift bar is not in pause or past mode, press ' button. The message 

"Do you want to stop Timeshift?" will appear.

2.	 Select OK button and press E button to stop Timeshift.

3.	 If the Timeshift bar is in pause or past mode, Timeshift mode will be changed 

into Live TV when you press ' button first time.

4.	 Press ' button again, then same message with above image appears.

5.	 Select Yes, and then press the E button.
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Playing the Recorded Title
1.	 Select the Recorded TV on the Home screen, then press the E button. The 

Recorded TV List will be displayed.

2.	 Select the desired device, then press the E button.

3.	 Select the title you want to play, then press the E button. The selected title 

will be played back.

"" Press the REC TV LIST button on the remote to display the Recorded TV List.

Using the View, Filter and Options 
Menus

Using the View Menu
On a file screen contaning video files, select  and then press the E button.

●● Title : Appears on the View function screen. Sort to Title.

●● Date : Appears on the View function screen. Sort to Date.

●● Channel : Appears on the View function screen. Sort to Channel.

"" Depending on the disc or storage device, the View menu may differ or not be shown.

Using the Filter Menu
On playback screen, select the Filter and press the E button.

●● All Contents : Appears all the recorded TV list.

●● Unwatched : Appears unwatched TV list.

https://manualsfile.com


88

Using the Options Menu
On playback screen or a file screen containing Recorded TV files, select the  and 

press the E button.

●● Play Selected : Play Selected lets you select specific tract to play. It works 

essentially the same for all media. See the "Repeating tracks on an Audio CD".

●● Lock : Select this menu to lock the file editing.

●● Unlock : Select this menu to unlock the file editing.

●● Delete : You can delete the file from the list.

●● Partial Delete : You can delete a title partially.

●● Split : You can split a title.

●● Rename : You can rename a title.

●● Manage Devices : Select this menu to manage device.

"" Depending on the disc or storage device, the Options menu may differ or not be 

shown.
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Editing the Recorded Title

Splitting a Section of a Title (Divide 
into two)
(Recorded TV → Options → Split)

1.	 In the Recorded TV screen, select the Options, then press the E button.

2.	 Select the Split, then press the E button.

3.	 Select the title you want to edit.

4.	 Using the playback-related buttons, move to a point for splitting and then 

press the E button.

5.	 Press the E button to select .

6.	 Press the E button to select Save. The split title is divided into two, and the 

following titles will be shifted down by one.

Splitting a Section of a Title (Partial 
Delete)
(Recorded TV → Options → Partial Delete)

1.	 In the Recorded TV screen, select the Options, then press the E button.

2.	 Select the Partial Delete, then press the E button.

3.	 Select the title you want to edit.

4.	 Press the E button at the starting point. The image and starting point time is 

displayed in the section deletion starting point window.

●● Select the start and end points of the section you want to delete using the 

playback related buttons.

5.	 Press the E button at the end point. The image and end point time is 

displayed in the Section deletion ending point window.

6.	 Press the E button to select Save.

7.	 Press the E button.

"" The minimum length of delete section should be longer than 5 seconds.
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Send files

Copying Videos, Music or Photos

Contents

DISC/HDD/
Network Device/
Cloud Service → 

USB

DISC/USB/
Network Device/
Cloud Service → 

HDD

DISC/HDD/
Network Device 
→ Cloud Service

DISC/HDD/
Cloud Service → 
Cloud Network 

Device

Music Supported Supported Supported Supported

Photos Supported Supported Supported Supported

Videos Supported Supported Supported Supported

●● Disc (CD-DA/CD-R/CD-RW, DVD±R(Finalise)/ DVD+RW/DVD-RW(Finalise)) → 

HDD or USB

●● PTP USB is not available when you copy to USB.

●● The broadcast signal can be recorded on external or internal HDD but copy 

feature is not supported.

1.	 Press the HOME button. The home screen will be displayed.

2.	 In Stop mode, connect the USB storage device to the USB port on the front 

panel of the product.

3.	 Select the desired contents type, then press the E button.

4.	 Select the Options, then press the E button.

5.	 Select the Send, then press the E button.

6.	 Select the desired contents.

7.	 Select the Send, then press the E button.

8.	 Select the desired destination device.
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3D Functions

Viewing DTV with the 3D effect
You can experience 3D effect with live TV and recorded TV programme with 3D 

contents.

1.	 During watching the TV programme or playing recorded TV programme, press 

the 3D button on your remote control. The 3D menu will appear.

●● Side by Side : Displays two images next to each other.

●● Top and Bottom : Displays one image above another.

2.	 Press the ◀▶ buttons to select the desired 3D mode, then press the E 

button.

3.	 If you press the 3D button once more during 3D viewing, displayed image will 

be changed into 2D mode.

"" If you change TV channel during watching DTV in 3D mode of Side by Side mode, 

displayed image will be changed into 2D mode automatically.

"" When 3D effect of Side by Side mode is enabled, you can not adjust 3D mode.

"" If TV programme is not support Side by Side, Top and Bottom mode or Auto Detection 

function, 3D menu selection OSD is not appear.
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Creating a Samsung Account
Create a Samsung account so you can take advantage of all Samsung has to offer 

on line. Set up accounts for each household member so each member can access 

their own accounts on Facebook, Twitter, etc. You also need a Samsung account if 

you want to download for-pay apps and rent Films.

1.	 On the Home screen, press the  button. The Sign In screen appears.

2.	 Select Create Account on the bottom right, and then press the E button. The 

Samsung account terms & conditions, privacy policy screen appears.

3.	 Press the E button to agree, press the ▶ button, and then press the E 

button. The Create a Account screen appears.

4.	 Select the ID field, and then press the E button. The keyboard pop-up 

appears.

5.	 Enter your e-mail address using the keyboard. Use the arrow buttons to 

move from character to character. Press E to select a character. Select the 

Caps button on the left to enter capitals. Select the 123#& button to select 

additional symbols.

6.	 When finished, select the Done button on the keyboard, and then press the E 

button. The Create screen reappears.

7.	 Enter a password, your first name, and last name in the same fashion.

8.	 Select the Date of Birth field, and then select numbers using the up and down 

arrow buttons or pressing numbers on your remote. Press the E button when 

done.

9.	 After you have finished with all the ields, press the ▶ button, and then 

press the E button. Connecting appears, and then the account confirmation 

message.

10.	Press the E button. The Set Profile Picture screen appears.

"" Samsung sends a confirming e-mail to the address you entered. You must open the 

e-mail and respond as requested to finalize your account.

11.	Select a picture to identify your account, and then press the E button. The 

Account Created screen appears.

12.	Press the E button. The Home screen appears.
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Before Using Samsung Apps
If you haven’t set up Smart Hub, when you use Samsung Apps for the first time, 

the product will ask you to perform the Smart Hub set up procedure.

1.	 On the Home screen, select either SAMSUNG APPS, and then press the E 

button. If you have selected SAMSUNG APPS, go to Step 4.

2.	 If you selected SAMSUNG APPS, the Smart Hub pop-up appears asking if 

you want to set up Smart Hub. Select Yes, and then press the E button. The 

Welcome screen appears.

3.	 Select Start, and then press the E button. The Terms and Policy screen 

appears.

4.	 On the Additional Services, Terms and Conditions and Choices screen, you 

must review and agree to both the Smart Hub Terms and Conditions and the 

Privacy Policy to use Smart Hub.

5.	 Scroll down, and then click the View Details buttons to review the full 

documents.

"" You do not need to consent to the Supplemental Privacy Notice, but one or more 

Smart TV features or functionalities may not be available if you do not.

6.	 Select I agree to all, and then press the E button. The Setup Complete screen 

appears. Press the E button.
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Using Films and TV Shows
If you haven’t set up Smart Hub, when you use Films and TV Shows for the first 

time, the product will ask you to perform the Smart Hub set up procedure. You can 

stream Films and TV Shows and view them on your TV.

FILMS AND TV SHOWS

Recommended

Favourites Featured Films TV Shows Trailers Trending

1.	 On the Home screen, select FILMS AND TV SHOWS, and then press the E 

button.

2.	 1) Select one of the Recommended Films, and then press the E button. The 

page for that movie appears. Use the ▼ button to go to the bottom of the 

screen. 2) Alternately, select Films or TV Shows and then press the E button. 

On the page that appears, use the ▲▼◀▶ buttons to select a show or movie, 

and then press the E button. On the Films or TV Shows screen, you can also 

select What’s New or Genres to see more available shows or Films. On the 

Genres screen, use the ▲▼◀▶ buttons to select a desired Genres, and then 

press the E button. To make a selection on a page displaying Films and TV 

Shows, use the ▲▼◀▶ buttons to make a selection, and then press the E 

button.

3.	 To watch a selection, select listed apps, and then press the E button.

"" The listed apps appears if you have not installed any of the movie apps you 

could use to watch the movie or TV show you selected. If none of these apps are 

installed on your product, select one of the apps, and then press the E button. 

You will be asked if you want to install the app. Select Install, press the E button, 

and then follow the directions that appear on the screen to install the app.
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4.	 Follow the directions on the screen to start the movie.

"" Contents items and the corresponding bottom menu in Films and TV Shows differ 

between countries.

"" When you activate Films and TV Shows for the first time, the listed apps may not be 

displayed. The listed apps is displayed after you download a video contents App for 

use. If the listed apps button is not displayed, you cannot watch contents.

"" Favorites will not appear unless you have tagged one or more films or TV shows as 

a favorite. To tag a movie or show as a favorite, select the show. The Detail screen 

appears. Select the heart symbol, and then press the E button. 

Using Samsung Apps
You can download applications from the Internet, and access various application 

and view them on your TV. To access some applications, you need to have a 

Samsung account.

The Samsung Apps Screen at a 
Glance

SAMSUNG APPS

Recommended

1 2

My Apps

WebBrowser e-Manual

Most Popular What’s New Categories
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●● Recommended : Displays recommended contents managed by Samsung. You 

cannot delete Recommended Apps.

●● My Apps : Displays your personal gallery of applications modifiable on the My 

Apps screen.

●● Most Popular, What’s New and Categories : Select to view and download 

additional apps.

The first time you open the Samsung Apps screen, the product automatically 

downloads a group of free apps. Once these apps have been downloaded, they 

appear on the Samsung Apps screen.

 To see additional apps, select Most Popular, What’s New, or Categories on the 

bottom of the screen, and then press the E button.

 Most Popular displays the most popular apps, What's new the newest. Categories 

displays a series of icons representing categories such as Videos, Games, and 

Sports. Select a category icon, and then press the E button. The product displays 

the apps in that category.

Downloading an App

1.	 Select Most Popular, What’s New, or Categories, and then press the E 

button.

2.	 If you selected Categories, select a category icon, and then press the E 

button. Otherwise, go to Step 3.

●●  On the Most Popular, What’s New, and Categories screens, a green arrow is displayed 

on apps you have already downloaded. 

3.	 Select an app you want to download, and then press the E button. The Detail 

Information screen for the app appears.

4.	 Select the Download button on the screen, and then press the E button. 

Download changes to Cancel and the app begins to download.

5.	 If you want to cancel the download, select Cancel, and then press the E 

button.

6.	 When the download is complete, Cancel changes to Play. Select Play, and then 

press the E button to start the application. Alternately, press the RETURN 

button until the Samsung Apps screen reappears. The app you downloaded 

will be displayed on the Samsung Apps screen under My Apps.

"" If the App cannot be downloaded due to insufficient remaining internal memory, 

connect a USB storage device and try again.
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Starting an Application
1.	 Select SAMSUNG APPS on the Home screen, and then press the E button.

2.	 On the SAMSUNG APPS screen, use the ▲▼◀▶ buttons to select an app, and 

then press the E button. The app starts.

The Option Menu

Move

1.	 On the My Apps screen, select the app you want to move on the My Apps 

screen, and then press the E button for 3 seconds. The Option menu appears.

2.	 Select Move, and then press the E button.

3.	 Use the ▲▼◀▶ buttons to move the app.

4.	 When the app is where you want it, press the E or EXIT button.

Delete

1.	 On the My Apps screen, select the app you want to delete and then press the 

E button for 3 seconds. The Option menu appears.

2.	 Select Delete, and then press the E button.

3.	 Use the ◀▶ buttons to select OK, and then press the E button.
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Delete Multiple

1.	 On the My Apps screen, select an app you want to delete and then press the 

E button for 3 seconds. The Options menu appears.

2.	 Select Delete Multiple, and then press the E button.

3.	 Use the ▲▼◀▶ buttons to select apps you want to delete, and then press the 

E button.

4.	 Use the ▼ buttons to select Delete, and then press the E button.

View Details

1.	 On the My Apps screen, select the app you want to see detailed information 

for, and then press the E button for 3 seconds. The Option menu appears.

2.	 Select View Details, and then press the E button.

3.	 The Update Apps screens lists all the apps that have updates available. Select 

each app you want to update, and then press the E button. You can also 

choose Select All to update all the apps listed.

4.	 Select Update, and then press the E button. 

Update Apps

1.	 On the My Apps screen, select any app, and then press the E button for 3 

seconds. The Option menu appears.

2.	 Select Update Apps, and then press the E button.

3.	 The Update Apps screens lists all the apps that have updates available. Select 

each app you want to update, and then press the E button. You can also 

choose Select All to update all the apps listed.

4.	 Select Update, and then press the E button. 
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Screen Mirroring
The Screen Mirroring function lets you view the screen of your smart phone or 

android tablet on the TV you have connected to the product.

1.	 In the Home screen, select Screen Mirroring, and then press the E button.

2.	 Launch AllShare Cast or Screen Mirroring on your device.

3.	 On your device, find the name of the product in the list of available devices 

and then select it.

4.	 The TV displays a connecting message (for example, Connecting to 

Android_92gb...) and then displays the connected message.

5.	 In a few moments, the screen of your device appears on the TV screen.

6.	 To stop Screen Mirroring, press the EXIT or RETURN button on the remote 

control, or exit the Screen Mirroring function on your smart phone.

"" You can connect to a device that supports AllShare Cast. Note that all devices that 

have AllShare Cast may not be fully supported, depending on the manufacturer. For 

further information on mobile connection support, refer to the manufacturer’s web site.

"" When you are using the Screen Mirroring function, video stuttering or audio dropouts 

may occur, depending on your environment.

"" Bluetooth transmissions can interfere with the Screen Mirroring signal. Before using 

the Screen Mirroring function, we strongly recommend that you turn off the Bluetooth 

function on your smart phone or smart device (tablet, etc.).
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Using the Web Browser
You can access the Internet using the Web Browser application.

Select WebBrowser on the Home screen, and then press the E button.

"" When you run the Web Browser with the product connected by HDMI to a BD Wise 

compatible TV - and BD Wise is on - the browser is maximized to fill the screen and 

the TV's resolution is set to the optimal resolution automatically. 

"" The Web Browser is not compatible with Java applications.

"" If you attempt to download a file, and the file cannot be saved, an error message will 

appear.

"" E-commerce (purchasing products online) is not supported.

"" ActiveX is not supported.

"" Access may be blocked to some websites or to web browsers operated by certain 

businesses.

Link Browsing and Pointer Browsing
The Web Browser provides two types of browsing, Pointer Browsing and Link 

Browsing. When you launch the browser for the first time, Pointer Browsing is 

active. If you are using a mouse to navigate in the Web Browser, we recommend 

leaving Pointer Browsing active. If you are using your remote to navigate in 

the Web Browser, we recommend that you replace Pointer Browsing with Link 

Browsing. Link Browsing moves a highlight from one link to the next in the Web 

Browser and is much faster than Pointer Browsing if you are using your remote.

To activate Link Browsing, follow these steps:

1.	 Use the ▲▼◀▶ buttons on your remote to move the pointer to the Link 

Browser icon on the top right of the screen. The Link Browser icon is the third 

icon from the right. The pointer will be in the correct position if the icon turns 

blue and the words “Link Browsing” appear on the screen.

2.	 Press the E button. Link Browsing is activated and will remain active 

whenever you bring up the Web Browser.
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The Control Panel at a Glance
The Control Panel, which runs across the top of the screen, has a series of icons 

which start a number of useful functions. The icons are described below, starting 

with the icon on the far left of the screen.

●●  : Moves to the previous page.

●●  : Moves to the next web page.

●●  : Displays the Bookmarks and History screen. You can bookmark the current 

page, select an existing bookmark, and edit and delete bookmarks. You can 

also view your browsing history and select a page to revisit.

●●  : Moves to the Home screen of the Web Browser.

●●  : Lets you enter a page address manually using the keyboard 

pop-up.

●●  : Reloads the current page so that it is refreshed on the screen.

●●  : Adds the current page to your bookmarks.
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●●  : Lets you search for information by entering words or characters using 

the keyboard pop-up. See "Using the Keyboard Pop-up".

●●  : Lets you enlarge or shrink the screen by various percentages.

●● /  : Lets you switch between Pointer Browsing and Link Browsing.

●●  : Lets you configure the Browser’s settings. See Using the Settings Menu.

●●  : Closes the Web Browser.

●●  : Opens a new web browser tab.

Using the Keyboard Pop-up 
When you click the , the  or access a data or text entry field, 

and then press the E button, the keyboard pop-up appears.

To use the keyboard pop-up with your remote, follow these steps:

As you enter characters, recommended text will be shown.

Caps 1 2 3 4 5 6 7 8 9 0 ← Clear

q w e r t y u i o p ^ *

123#& a s d f g h j k l ~ @ ! Done

ENG

z x c v b n m , . ? Cancel

www. .com /

1.	 Use the ▲▼◀▶ buttons on your remote to move the highlight to a letter or 

number of your choice.

2.	 Press the E button to enter the letter or number into the entry field.

3.	 To access capital letters, move the highlight to the Caps key on the top left, 

and then press the E button. Press the E button again with the Caps key 

highlighted to access small letters again.
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4.	 To access symbols and additional punctuation marks, highlight the 123#& 

button on the left, and then press the E button.

5.	 To delete a character you entered, move the highlight to the ← button, and 

then press the E button.

6.	 To delete all the characters you entered, move the highlight to the Clear 

button, and then press the E button.

7.	 When finished entering, move the highlight to the Done button, and then press 

the E button.

"" If you have a wireless keyboard connected to your product, you can use the wireless 

keyboard to enter letters, numbers, symbols, and punctuation. Note that the wireless 

keyboard will work only when the keyboard popup appears and can only be used to 

enter letters, numbers, symbols, and punctuation.

Options on the Keyboard Pop-Up
To access the keyboard pop-up options, highlight the  button on the bottom left 

of the keyboard, and then press the E button.

●● Language : Select the language for the keyboard. You can select English, French, 

Russian, etc.

●● Recommended Text : The keyboard suggests recommended words as you enter 

text. You can turn this function On or Off.

●● Reset recommended text data : Reset erases the Samsung Keyboard's memory. 

Select Reset to erase everything that the Samsung Keyboard has learned about 

your writing style, including any new words you have used.

●● Predict Next Letter : The keyboard predicts the next letter as you enter letters. 

The predictions appear in a ring around the letter you have just entered. 

You can select a predicted letter or move to another letter. You can turn this 

function On or Off.

●● Accented character preview : Select this if you want to type letters with accent 

marks.
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Using the Setting Menu
The Setting menu contains functions that control how the Browser operates and 

Browser security functions. To open the Setting menu, highlight the  icon in the 

Control Panel, and then press the E button. To select an option in the setting 

menu, highlight the option, and then press the E button.

●● Enable/Disable Grabbing : Turns the Grabber function on and off. When the 

Grabber function is on, you can move a web page up and down without 

dragging the scroll bar. The Grabber function is only available in Pointer 

Browsing.

●● Approved Sites : Lets you restrict your children’s access to inappropriate web 

pages by allowing access only to the web sites you have registered. Every 

time you access this function, the PIN screen appears. The first time you 

access this function, enter the default PIN, 0000 using the number buttons 

on your remote. You can change the PIN using the Reset password for the 

Approved Sites function. See below. 

–– Approved Sites Feature : Turns the Approved Sites function on or off. 

–– Reset password for Approved Sites : Change the Approved Sites 

password. 

–– Add current site : Lets you add the currently displayed web site to the 

Approved Sites list. 

–– Manage Approved Sites : Lets you key in URLs to add to the Approved 

Sites List and delete sites from the Approved Sites list. If you turn this 

function on and have not added any sites to the Approved Sites list, you 

will not be able to access any Internet sites.

●● Private Browsing On/Off : Enable or disable the Privacy mode. When the Privacy 

mode is enabled, the browser does not retain the URLs of sites you visit. If 

you want to enable Privacy mode, select OK. If the Privacy mode is running, 

the “Stop” icon appears in front of the URL at the top of the screen. To disable 

Privacy mode, select it again when Privacy mode is enabled.

●● Set Search Engine : You can set the desired Search Engine.
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●● Web Browser Setting

–– Set as homepage : You can set the Browser's home page. 

–– Pop-up Block : Turns the Popup Block on and off. 

–– Page Block : You can determine whether to block advertisements and 

select the URLs for which advertisements are blocked. 

–– General : You can delete personal information such as website history and 

browsing data (cookies, etc.), and reset all web browser settings to their 

factory defaults. You can also set the Security Mode.

"" Set the Security Mode to On to avoid accessing malicious/phishing sites and 

prevent malicious code from running.

–– Encoding : You can set the Encoding setting for web pages to Automatic 

or select the encoding format manually from a list. 

–– Pointer : You can set the speed of the cursor when the cursor is set to 

Pointer and turn Smart Cursor On and Off. 

–– Browser Information : Displays the version number and copyright 

information for the Web Browser.

●● Help : Provides basic information about the operation of the Web Browser.

"" Depending on the web site, some of the Web Browser Setting functions may not be 

activated. Functions that are not activated are greyed out and cannot be used. 
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Linking Your Internet Service 
Accounts to the product
The Link Service Accounts function lets you link your product to your accounts 

with Internet services such as Pandora so that the product can log you in to the 

service automatically when you start the app for that service.

Register your account by going to HOME → Sign In → Create with Facebook.
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Supported Formats

Video File Support

File 
Extention

Container Video Codec Resolution
Frame 

rate (fps)
Bit rate 
(Mbps)

Audio Codec

MVC 24/25/30 60

*.avi

*.mkv
Motion JPEG

*.asf

*.wmv

H.264 BP/MP/
HP

*.mp4

*.mov

AVI

MKV

Divx 3.11 / 4 / 
5 / 6

AC3

*.3gp

*.vro

ASF

MP4

MPEG4 
SP/ASP

1920x1080 LPCM

*.mpg

*.mpeg

3GP

MOV

Window Media 
Video v9(VC1)

ADPCM(IMA, 
MS)

AAC

*.ts

*.tp

FLV

VRO
AVS

FHD: MAX 
30

HD : MAX 
60

30
HE-AAC

WMA

*.trp

*.mov

VOB

PS
MPEG2 

Dolby Digital 
Plus

*.flv

*.vob

TS

SVAF
MPEG1

MPEG(MP3)

DTS

*.svi

*.m2ts

Microsoft 
MPEG-4 v1, 

v2, v3

*.mts

*.divx

H 263 
Sorrenson

1280x720

*.ps
Window Media 

Video v7(WMV1), 
v8(WMV2)

VP6 640x480 6~30 4

*.webm WebM VP8 1920x1080 6~30 20 Vorbis

Appendix
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Limitations

–– Even when a file is encoded by a supported codec listed in the Video File 

Support table, the file might not play if its content has a problem.

–– Normal playback is not guaranteed if the file’s container information is wrong or 

the file itself is corrupted.

–– Files having a higher Bit rate/frame rate than indicated in the Video File Support 

table may stutter when played back.

–– Seek (Jump) function is not available if the file’s index table is damaged.

–– When you playback a file remotely through a network connection, video 

playback may stutter depending on the network speed.

–– Some USB/Digital camera devices may not be compatible with the product.

–– The AVS codec is supported only by models made for China.

–– The *.ps file extension is supported only by models made for China.

–– The DivX codec is not supported by models made for America.

–– If the original content of a file was recorded in UHD, it cannot be played.

Video decoder

–– Supports up to H.264 Level 4.1. (Does not support FMO/ASO/RS)

––  Does not support VC1/AP/L4.

–– CODECs except for WMVv7, v8, MSMPEG4 v3, MVC, VP6

●● Below 1280 x 720 : 60 frames max.

●● Above 1280 x 720 : 30 frames max.

–– Does not support GMC 2 or higher.

–– Supports SVAF Top/Bottom, Side by Side, Left/Right view sequence type(2 ES)

–– Supports BD MVC Spec.

https://manualsfile.com


108 109

Audio decoder

–– Supports WMA 10 PRO (Up to 5.1).

–– Does not support WMA lossless audio.

–– Also supports the M2 profile.

–– The RealAudio 10 lossless format is not supported by models made for China 

and Hong Kong.

–– Does not support QCELP/AMR NB/WB.

–– Supports vorbis (Up to 2ch).

–– Supports DD+ (Up to 5.1ch)

–– The DTS LBR codec is supported only for MKV / MP4 / TS containers.

Supported DivX subtitle file formats

*.ttxt, *.smi, *.srt, *.sub, *.txt

"" Some DivX, MKV and MP4 format discs may not play, depending on their video 

resolution and frame rate.

Supported Subtitle File Formats

Name File Extension

MPEG-4 Timed text .ttxt

SAMI .smi

SubRip .srt

SubViewer .sub

External Micro DVD .sub or .txt

SubStation Alpha .ssa

Advanced SubStation Alpha .ass

Powerdivx .psb

SMPTE-TT Text .xml

Xsub AVI

SubStation Alpha MKV

Advanced SubStation Alpha MKV

SubRip MKV

Internal VobSub MKV

MPEG-4 Timed text MP4

TTML in smooth streaming MP4

SMPTE-TT TEXT MP4

SMPTE-TT PNG MP4
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Music File Support

File Extension Type Codec Support Range

*.mp3 MPEG MPEG1 Audio Layer 3 -

*.m4a

*.mpa

*.aac

MPEG4 AAC -

*.flac FLAC FLAC
Supports up to two 

channels.

*.ogg OGG Vorbis
Supports up to two 

channels.

*.wma WMA WMA

For WMA. Supports up 
to 10 Pro 5.1 channels.

WMA lossless audio 
is not supported.

Supports up to M2 
profile.

*.wav wav wav -

*.mid

*.midi
midi midi

Type 0, type 1 and 
Seek is not supported.

Only available with 
USB.

*.ape ape ape
NVT and X13 is not 

supported.

*.aif

*.aiff
AIFF AIFF -

*.m4a ALAC ALAC -
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Picture File Support

File Extension Type Resolution

*.jpg

*.jpeg
JPEG 15360x8640

*.png PNG 4096x4096

*.bmp BMP 4096x4096

*.mpo MPO 15360x8640

AVCHD (Advanced Video Codec High 
Definition)

●● This product can play back AVCHD format discs. These discs are normally 

recorded and used in camcorders.

●● The AVCHD format is a high definition digital video camera format.

●● The MPEG-4 AVC/H.264 format compresses images with greater efficiency than 

the conventional image compressing format.

●● Some AVCHD discs use the "x.v.Color" format. This product can play back 

AVCHD discs that use "x.v.Color" format.

●● "x.v.Color" is a trademark of Sony Corporation.

●● "AVCHD" and the AVCHD logo are trademarks of Matsushita Electronic Industrial 

Co., Ltd. and Sony Corporation.

"" Some AVCHD format discs may not play, depending on the recording condition. 

AVCHD format discs need to be finalized.

"" "x.v.Color" offers a wider colour range than normal DVD camcorder discs.
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Troubleshooting
Before requesting service, please try the following solutions.

PROBLEM SOLUTION

No operation can be performed 
with the remote control.

Check the batteries in the remote control. They may need 
replacing.
Operate the remote control at a distance of no more than 
6.1m.
Remove the batteries and hold down one or more buttons 
for several minutes to drain the microprocessor inside the 
remote control to reset it. Reinstall the batteries and try to 
operate the remote control again.

Disc does not play.
Ensure that the disc is installed with the label side facing 
up.
Check the region number of the Blu-ray/DVD disc.

Disc Menu does not appear. Ensure that the disc has disc menus.

The prohibition message ap-
pears on the screen.

This message appears when an invalid button is pressed.
The Blu-ray Disc/DVD’s software doesn’t support the fea-
ture (e.g., angles).
You’ve requested a title or chapter number or search time 
that is out of range.

Play mode differs from the 
Setup Menu selection.

Some of the functions selected in the Setup Menu may not 
work properly if the disc is not encoded with the corre-
sponding function.

The screen ratio cannot be 
changed.

The Screen Ratio is fixed on your Blu-ray/DVD disc.
This is not a problem with the product.

No audio.
Make sure you have selected the correct Digital Output in 
the Audio Options Menu.

The screen is blocked

If the HDMI output is set to a resolution your TV cannot 
support (for example, 1080p), you may not see a picture on 
your TV.
Press the ' button (on top panel) for more than 5 seconds 
with no disc inside on the home screen. All settings will 
revert to the factory settings.
When the factory default settings are restored, all stored 
user BD data is deleted.

Forgot PIN

Press the ' button (on top panel) for more than 5 seconds 
with no disc inside on the home screen. All settings includ-
ing the PIN will revert to the factory settings. Don’t use this 
unless absolutely necessary.
When the factory default settings are restored, all stored 
user BD data is deleted.
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PROBLEM SOLUTION

If you experience other prob-
lems.

Go to the contents and find the section of the user manual 
that contains the explanations regarding the current prob-
lem, and follow the procedure once again.
If the problem still cannot be solved, please contact your 
nearest Samsung authorised service centre.

The picture is noisy or distort-
ed

Make sure that the disc is not dirty or scratched.
Clean the disc.

No HDMI output.

Check the connection between the TV and the HDMI jack of 
the product.
Check if your TV supports 576p, 720p, 1080i, 1080p HDMI 
input resolution.

Abnormal HDMI output screen.
If random noise appears on the screen, it means that TV 
does not support HDCP (High-bandwidth Digital Content 
Protection).

Play Multimedia files on network devices

I can see folders shared on 
network devices, but I cannot 
see the files.

Multimedia list shows only files corresponding to the Vid-
eos, Photos, and Music categories. Files that do not corre-
spond to these categories may not be displayed.

Video is played intermittently.

Check if the network is stable. 
Check if the network cable is properly connected and if the 
network is not overloaded. 
The wireless connection between the DLNA compatible 
device and the product is unstable. Check the connection.

Network connection between 
product and PC is unstable.

The IP address under the same subnetwork should be 
unique. If they are not, IP interference can cause this phe-
nomenon. 
Check if you have a firewall enabled. If so, disable the fire-
wall function.
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PROBLEM SOLUTION

BD-Live

I cannot connect to the BD-
Live server.

Check whether the network connection is successful or not 
by using the Network Status menu. 
Check whether the USB memory device is connected to the 
product.
The memory device must have at least 1 GB of free space 
to accommodate the BD-Live service. You can check the 
available size in Delete BD Data. 
Check whether the BD-Live Internet Connection menu is set 
to Allow(All). 
If all above fails, contact the contents provider or update 
the product to the latest firmware.

When using the BD-Live ser-
vice, an error occurs.

The memory device must have at least 1 GB of free space 
to accommodate the BD-Live service. You can check the 
available size in Delete BD Data. 

Recording

"Performance test failed." 
message appears, and also 
Schedule Recording / record-
ing and Timeshift function 
does not work.

Using lower quality USB storage device not supporting Re-
cording function can cause this kind of problem. It is rec-
ommended to use USB HDD storage device.
Recommended specification of USB HDD is at least 5400 
rpm. USB HDD of RAID type is not supported.

Pay channel

Can not view Pay channel with 
connection CI(+) CAM

Check whether the firmware of CAM is upgraded for com-
patiblity with CI+ 1.3Version. 
Some CAM's in the market with older firmware versions 
are not fully interoperable with this device that is compliant 
to v1.3 specification.
It is a problem of legacy CAMs, not this CI Plus compliant 
device.
In this case, this problme can be resolved by applying a 
firmware upgrade to the CAMs.
So, please contact your network operator or CAM operator 
for it.

"" When the factory default settings are restored, all stored user BD data is deleted.
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